
ANALISIS PENGARUH METODE PERSEDIAAN RATA-
RATA TERTIMBANG, PERPUTARAN PERSEDIAAN, DAN
TAX AVOIDANCE TERHADAP MARKET VALUE
PERUSAHAAN

INFLUENCE ANALYSIS METHOD WEIGHTED AVERAGE
INVENTORY, INVENTORY TURNOVER AND MARKET VALUE
OF TAX AVOIDANCE COMPANY

PUTRI WULANDARI
8335108439

Skripsi ini Disusun Sebagai Salah Satu Persyaratan Untuk Memperoleh
Gelar Sarjana Ekonomi

PROGRAM STUDI S1 AKUNTANSI
JURUSAN AKUNTANSI
FAKULTAS EKONOMI
UNIVERSITAS NEGERI JAKARTA
2014





PERNYATAAN ORISINALITAS

Dengan ini saya menyatakan bahwa:

1. Skripsi ini merupakan karya asli dan belum pernah diajukan untuk

mendapatkan gelar akademik sarjana, baik di Universitas Negeri Jakarta

maupun di perguruan Tinggi lain.

2. Skripsi ini belum pernah dipublikasikan, kecuali secara tertulis dengan jelas

dicantumkan sebagai acuan dalam naskah dengan disebutkan nama pengarang

dan dicantumkan dalam daftar pustaka.

3. Pernyataan ini saya buat dengan sesungguhnya dan apabila di kemudian hari

terdapat penyimpangan dan ketidakbenaran, maka saya bersedia menerima

sanksi akademik berupa pencabutan gelar yang telah diperoleh, serta sanksi

lainnya sesuai dengan norma yang berlaku di Universitas Negeri Jakarta.

Jakarta, Juni 2014

Yang membuat pernyataan,

Putri Wulandari
8335108439



ABSTRAK

Putri Wulandari, 2014: Analisis Pengaruh Penerapan Metode Rata-Rata
Tertimbang, Perputaran Persediaan, dan Tax Avoidance Terhadap Market Value
Perusahaan.
Pembimbing : (1) Ratna Anggraini ZR, SE, Akt,M.Si,CA (2) Nuramalia Hasanah,
SE, M.Ak

Penelitian ini bertujuan untuk mendapatkan bukti empiris mengenai
analisis pengaruh Metode Persediaan Rata-Rata Tertimbang, Perputaran
Persediaan, dan Tax Avoidance Terhadap Market Value Perusahaan. Faktor-
faktor yang diuji dalam penelitian ini adalah Penerapan Metode Persediaan
Rata-Rata Tertimbang, Perputaran Persediaan, dan Tax Avoidance sebagai
variabel independen sedangkan Market Value Perusahaan sebagai variabel
dependen.

Sampel penelitian ini berdasarkan Perusahaan Manufaktur Sektor Aneka
Industri. Data yang digunakan dalam penelitian ini adalah data sekunder dan
pemilihan sampel dengan menggunakan metode purposive sampling. Alat analisis
yang digunakan adalah analisis regresi data panel dengan signifikansi 5%. Hasil
pengujian hipotesis secara stimultan menunjukkan bahwa ketiga variabel bebas
dan satu variabel terikat yaitu Penerapan Metode Persediaan Rata-Rata
Tertimbang, Perputaran Persediaan, dan Tax Avoidance berpengaruh terhadap
Market Value Perusahaan secara simultan.

Sedangkan hasil penelitian secara parsial menunjukkan bahwa Penerapan
Metode Rata-Rata Tertimbang dan Perputaran Persediaan yang berpengaruh
terhadap Market Value Perusahaan. Akan tetapi tidak ditemukan bukti bahwa
Tax Avoidance berpengaruh terhadap Market Value Perusahaan.

Kata kunci: Metode Persediaan Rata-Rata Tertimbang, Perputaran Persediaan,
Tax Avoidance, dan Market Value Perusahaan.



ABSTRACT

Putri Wulandari, 2014: Analisis Pengaruh Penerapan Metode Rata-Rata
Tertimbang, Perputaran Persediaan, dan Tax Avoidance Terhadap Market Value
Perusahaan.
Pembimbing : (1) Ratna Anggraini ZR, SE, Akt,M.Si,CA (2) Nuramalia Hasanah,
SE, M.Ak

This study aims to obtain empirical evidence about the influence analysis
method Weighted Average Inventory, Inventory Turnover, and Tax Avoidance
Against Market Value Company. The factors examined in this study is Application
Method Weighted Average Inventory, Inventory Turnover, and Tax Avoidance as
an independent variable while the Market Value Company as the dependent
variable. The sample of this study is based on various Industrial Manufacturing
Sector.

The data used in this study are secondary data and the selection of the
sample using purposive sampling method. The analytical tool used is panel data
regression analysis with significance of 5%. Simultaneous hypothesis testing
results show that all three independent variables and the dependent variable is
the Implementation Method of Weighted Average Inventory, Inventory Turnover,
Tax Avoidance and the effect on the Company's Market Value simultaneously.

While the partial results of the study showed that the application of
methods and the Weighted Average Inventory Turnover affecting the Company's
Market Value. However, no evidence that the effect on Tax Avoidance Market
Value Company.

Keywords: Method of Weighted Average Inventory, Inventory Turnover, Tax
Avoidance, and Market Value Company
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BAB I

PENDAHULUAN

A. Latar Belakang Masalah

Banyaknya perusahaan yang berkembang, serta kondisi

perekonomian saat ini telah menciptakan suatu persaingan yang ketat antar

perusahaan. Persaingan dalam perusahaan membuat setiap perusahaan

untuk meningkatkan kinerjanya agar setiap tujuannya dapat tercapai, yaitu

meningkatkan kesuksesan nilai pasar perusahaan. Kesuksesan suatu

perusahaan dalam mempertahankan eksistensinya tidak luput dari peran

manajer keuangan dan pengaruh keputusan keuangan yang telah dilakukan

dalam merencanakan pengadaan dan penggunaan dana untuk

memaksimumkan nilai perusahaan. Memaksimumkan nilai perusahaan

tidak identik dengan memaksimumkan laba, apabila laba tersebut diartikan

sebagai laba akuntansi, sebaliknya memaksimumkan nilai perusahaan akan

identik dengan memaksimumkan laba ekonomi. Hal ini disebabkan karena

laba ekonomi diartikan sebagai jumlah kekayaan yang bisa dikonsumsikan

tanpa mengurangi modal pemilik perusahaan.

Penilaian kinerja sangat bermanfaat bagi investor dalam

mengambil keputusan untuk berinvestasi maka diperlukan penelitian

tentang pengukuran kinerja dengan menggunakan market value

perusahaan. Market Value dari perusahaan menyajikan suatu nilai yang



melekat pada perusahaan tersebut yang tercermin dari harga saham

perusahaan yang ditawarkan di pasar. Dan untuk mengetahui market value

perusahaan, maka diperlukan salah satu sumber informasi yang penting

dan dapat memberikan gambaran kondisi keuangan perusahaan pada

periode waktu tertentu yang dapt dicapai perusahaan adalah laporan

keuangan. Market Value Perusahaan kaitannya dengan laporan keuangan

diuraikan oleh teori pasar efisien. Dalam pasar efisisen, harga-harga

mencerminkan sepenuhnya informasi yang tersedia (Belkaoui, 2004).

Dalam penyusunan laporan keuangan harus dapat dipahami dan

mudah dimengerti, informasi yang disajikan dalam laporan keuangan

harus relevan untuk memenuhi kebutuhan pemakai laporan keuangan

dalam proses pengambilan keputusan serta harus dilakukan secara

konsisten agar dapat diperbandingkan. Pada laporan keuangan perusahaan

terdapat metode persediaan rata-rata tertimbang. Metode Persediaan Rata-

Rata Tertimbang yang menggunakan suatu harga pokok tunggal yang akan

digunakan untuk menghitung harga pokok barang yang dijual atau barang

yang masih ada dalam persediaan atau dapat diasumsikan bahwa biaya

setiap barang ditentukan berdasarkan biaya rata-rata tertimbang dari

barang serupa pada awal periode dan biaya barang serupa yang dibeli atau

diproduksi selama periode. Perbedaan dampak penerapan metode

akuntansi persediaan akan ditanggapi oleh investor. Investor akan lebih

menyukai metode akuntansi yang menghasilkan laba yang relatif stabil,

karena informasi ini dapat digunakan untuk memprediksi kemungkinan



arus kas dimasa yang akan datang dan return bagi investor. Selain itu,

kemampuan deviden yang tinggi dan laporan keuangan yang prediktif juga

akan ditanggapi oleh para oleh para investor dengan menginvestasikan

dananya pada perusahaan. Investasi ini berdampak pada naiknya harga

saham perusahaan. Kenaikan harga saham mencerminkan kenaikan market

value perusahaan.

Sehubungan dengan kandungan informasi yang disajikan

perusahaan dengan laba perusahaan sebagai indikator, ada fenomena yang

terjadi di Bursa Efek Indonesia dimana harga saham suatu perusahaan

seringkali bereaksi setiap kali ada publikasi atas pencapaian penjualan atau

laba suatu perusahaan.

Salah satu contoh ketika PT. Astra Internasional Tbk (ASII)

mengumumkan bahwa perusahaan meraih pendapatan Rp129,99 triliun,

atau meningkat 31,93% dibanding pendapatan di tahun 2009 dan laba

bersih melejit 43% (Kontan, 25 Februari 2011), harga saham ASII

langsung bereaksi dari harga pembukaan Rp 51.400,- pada tanggal

25 Februari 2011 ditutup menjadi Rp 51.550,- pada hari yang sama.

Harga saham ini terus meningkat hingga mencapai Rp 54.000,- pada

penutupan tanggal 28 Februari 2011 (http://finance.yahoo.com).

Contoh kasus lain, tanggal 21 Februari 2010 PT. Astra Otoparts

Tbk (AUTO) mengeluarkan pernyataan bahwa perseroan membidik

kenaikan pendapatan tahun ini minimal Rp 5,79 triliun, angka ini naik

10% jika dibandingkan dengan pendapatan perseroan tahun lalu



(www.etrading.co.id). Pada hari yang sama, pasar langsung bereaksi

dimana harga pada sesi pembukaan adalah Rp 12.900,- dan pada tanggal

24 Februari 2010 naik menjadi Rp 13.950,- pada sesi penutupan.

Laba perusahaan dihasilkan dari penjualan perusahaan, semakin tinggi

tingkat penjualan perusahaan, maka laba perusahaan pun akan meningkat.

Dari kedua contoh kasus tersebut terlihat bahwa harga saham langsung

naik seiring dengan meningkatnya perolehan penjualan dan laba (profit).

Karena market value perusahaan diukur dengan harga saham, maka dapat

dikatakan dengan meningkatnya harga saham maka market value

perusahaan pun meningkat.

Nilai persediaan pun juga menjadi modal utama kerja, karena

selalu dalam keadaan berputar, dimana secara terus menerus akan

mengalami perubahan. Kandungan informasi dalam laporan keuangan

perusahaan dipengaruhi nilai dari masing-masing instrumen keuangan

yang terdapat dalam laporan keuangan tersebut, salah satunya adalah nilai

persediaan. Investasi dalam persediaan menentukan kelancaran operasi

perusahaan, maka persediaan akan berdampak pada laporan laba rugi dan

neraca. Laporan laba rugi dan neraca merupakan salah satu informasi

fundamental yang diperlukan oleh investor untuk menganalisis kinerja

perusahaan.

Berdasarkan informasi tersebut investor akan menentukan posisi

tawarnya tentang nilai saham perusahaan. Dengan demikian, kandungan

informasi dan arti penting neraca dan laporan laba rugi akan memberi



makna yang berbeda bagi investor. Sehubungan dengan kandungan

informasi yang disajikan perusahaan dengan laba perusahaan sebagai

indikator, dimana harga saham suatu perusahaan seringkali bereaksi setiap

kali ada publikasi atas pencapaian penjualan atau laba suatu perusahaan.

Tinggi rendahnya perputaran persediaan mempunyai efek yang langsung

terhadap besar kecilnya modal yang diinvestasikan dalam inventory.

Makin tinggi turnovernya, berarti makin cepat perputarannya sehingga

profitabilitas tinggi. Jika hal ini terjadi maka akan berpengaruh terhadap

market value perusahaan.

Hal lain yang berkaitan dengan market value perusahaan yang akan

diteliti adalah tax avoidance, yaitu upaya wajib pajak untuk tidak

melakukan perbuatan yang dikenakan pajak atau upaya-upaya yang masih

dalam kerangka ketentuan perundang-undangan perpajakan untuk

memperkecil jumlah pajak terhutang. Dimana pemilik saham yang

risk–neutral akan menerima manajer bertindak atas nama mereka untuk

mencapai profit maksimal, termasuk mengurangi kewajiban pajak selama

keuntungan yang diharapkan masih berada di atas biaya yang diperkirakan

Pemisahan kepemilikan dan manajemen mengarahkan keputusan pajak

perusahaan mencerminkan kepentingan pribadi manajer. Pemisahan

kepemilikan dan pengawasan ini menunjukkan bahwa tax avoidance

sebagai aktivitas yang penting, sehingga pemilik perlu merancang insentif

dan pengawasan yang tepat bagi manajemen agar manajer mengambil



keputusan pajak yang efektif dan efisien, yaitu ketika biaya yang harus

dikeluarkan masih lebih kecil daripada benefit yang akan diterima.

Seperti kasus dalam Laporan Senat AS pada tanggal 21 Mei 2013

yang menemukan bahwa perusahaan komputer raksasa Apple menghindari

pembayaran pajak untuk laba yang mencapai puluhan miliar dolar dengan

cara menyebar rekening ke jaringan anak perusahaannya yang kompleks.

Laporan itu tidak menuduh Apple melakukan tindakan melanggar hukum,

teatapi mengatakan bahwa banyak anak perusahaan Apple yang tidak

terdaftar untuk pembayaran pajak. Laporan menyebutkan perusahaan yang

utama, dengan alamat kota Cork di Irlandia, tidak membayar pajak selama

lima tahun belakangan (bbc.co.uk).

Tax avoidance menggambarkan sebuah kelanjutan dari strategi

perencanaan perpajakan perusahaan. Aktivitas tax avoidance

memunculkan kesempatan bagi manajemen dalam melakukan aktivitas

yang didisain untuk menutupi berita buruk atau menyesatkan investor

(Desai dan Dharmapala, 2006). Manajer dapat membenarkan transaksi atas

tax avoidance dengan mengklaim bahwa kompeksitas dan ketidaktauan

menjadi hal yang penting dalam meminimalkan terdeteksinya aktivitas tax

avoidance pemeriksa pajak.



Berdasarkan latar belakang tersebut, penelitian ini mengambil

judul ”ANALISIS PENGARUH METODE PERSEDIAAN RATA-

RATA TERTIMBANG, PERPUTARAN PERSEDIAAN DAN TAX

AVOIDANCE TERHADAP MARKET VALUE PERUSAHAAN”

B. Identifikasi Masalah

Berdasarkan uraian latar belakang, maka dapat diidentifikasi

beberapa masalah yang berkaitan dengan metode persediaan rata-rata

tertimbang, perputaran persediaan dan tax avoidance, yaitu sebagai

berikut:

1. Dengan metode persediaan rata-rata tertimbang menghasilkan laba

maksimal yang berdampak positif bagi perusahaan kepada para

investor.

2. Market value perusahaan menurun jika perputaran persediaan

perusahan rendah.

3. Tindakan tax avoidance dilakukan perusahaan untuk mencapai profit

maksimal namun rawan terdeteksi pemeriksa pajak.

4. Perbedaan metode persediaan rata-rata tertimbang, perputaran

persediaan dan tax avoidance merubah market value perusahaan.



C. Pembatasan Masalah

Dalam Penelitian ini peneliti membatasi masalah pada pengaruh

metode persediaan rata-rata tertimbang, perputaran persediaan dan tax

avoidance terhadap market value perusahaan di perusahaan manufaktur

sektor aneka industri dengan data yang dikumpulkan empat tahun terakhir

(2010-2013).

D. Perumusan Masalah

Berdasarkan pembatasan masalah tersebut, maka permasalahan

dalam penelitian dapat dirumuskan sebagai berikut:

1. Apakah metode persediaan rata-rata tertimbang  mempengaruhi market

value perusahaan?

2. Apakah perputaran persediaan mempengaruhi market value

perusahaan?

3. Apakah tax avoidance mempengaruhi market value perusahaan?

4. Apakah  metode persediaan rata-rata tertimbang, perputaran persediaan

dan tax avoidance dapat  mempengaruhi market value perusahaan?

E. Kegunaan Penelitian

Hasil penelitian ini diharapakan dapat memberikan manfaat baik

secara teoritis maupun praktis untuk berbagai pihak yang memiliki kaitan

dengan penelitian ini. Adapun kegunaan dari penelitian ini adalah sebagai

berikut:



1. Kegunaan Teoritis

a. Melalui penelitian ini, penulis mencoba memberikan bukti

mengenai analisis pengaruh metode persediaan rata-rata

tertimbang, perputaran persediaan dan tax avoidance terhadap

market value perusahaan oleh perusahaan manufaktur.

b. Penelitian ini diharapkan dapat menjadi referensi dan memberikan

sumbangan konseptual bagi peneliti sejenis maupun civitas

akademika lainnya dalam rangka mengembangkan ilmu

pengetahuan.

2. Kegunaan Praktis

a. Bagi Manajer

Penelitian ini dapat digunakan sebagai masukan bagi

manajer keuangan di perusahaan manufaktur dalam rangka

menjaga dan meningkatkan kinerjanya.

b. Bagi Investor

Hasil penelitian ini diharapkan dapat memberikan

kontribusi positif bagi para investor sebelum melakuan investasi

dan dalam metode persediaan rata-rata tertimbang, perputaran

persediaan dan tax avoidance terhadap market value perusahaan.



BAB II

KAJIAN TEORETIK

A. Deskripsi Konseptual

1. Market Value Perusahaan

Market value perusahaan dalam kaitannya dengan laporan

keuangan diuraikan oleh teori pasar efisien. Dalam pasar efisien,

harga-harga mencerminkan sepenuhnya  informasi  yang tersedia

(Belkaoui, 2004). Market value dari suatu  perusahaan menyajikan

suatu  nilai yang melekat pada perusahaan tersebut  berdasarkan pasar.

Market Value tersebut tercermin dari harga saham perusahaan yang

ditawarkan di pasar. Harga pasar dari perusahaan adalah sesungguhnya

mencerminkan  nilai  pasarnya  (Kam,  1990). Nilai  pasar  merupakan

harga  pasar riil dan  harga  yang  paling  mudah  ditentukan karena

merupakan harga  dari  suatu  saham  perusahaan  pada  pasar  yang

sudah  berlangsung atau  sudah  tutup  berdasarkan  bursa  utama.

Harga  pasar  merupakan  harga  jual  saham sebagai konsekuensi dari

posisi tawar  antara penjual dan pembeli saham sehingga nilai pasar

menunjukkan  fluktuasi  dari  harga  saham.

Nilai ini juga dikenal sebagai nilai pasar wajar, yaitu nilai setiap

aktiva, atau kumpulan aktiva pada saat diperdagangkan dalam suatu

transaksi tanpa beban dan tanpa paksaan. Nilai pasar tentu saja juga

dapat diciptakan melalui transaksi-transaksi perorangan apabila tidak



tersedia pasar yang terorganisir. Namun nilai pasar menunjukkan

kosensus sementara dari dua pihak atau lebih. Nilai pasar pada suatu

saat karenanya dapat dipengaruhi oleh pilihan dan tingkah laku dari

mereka yang terlibat di pasar, suasana psikologis yang ada di pasar,

sengitnya perang pengambilalihan (takeover), perubahan ekonomi,

perkembangan industri, kondisi politik, dan sebagainya (Erich A.

Helfert, 1997:290).

Nilai pasar juga sering digunakan dalam penjualan persediaan dan

dalam analisis investasi modal yang berbentuk nilai pemulihan pada

masa yang akan datang. Nilai pasar yang sebenarnya ditentukan hanya

berdasarkan keterlibatan dalam transaksi yang benar-benar terjadi.

Jadi, nilai pasar berdasarkan banyak transaksi yang sama dapat

ditetapkan nilainya hanya dalam rentang tertentu, yang ada gilirannya

tergantung pada kondisi perdagangan harian, mingguan, maupun

bulanan.

Menurut Suharli (2006), ada beberapa pendekatan yang biasa

dilakukan untuk menilai perusahaan, di antaranya:

a. Pendekatan laba antara lain metode rasio tingkat laba.

b. Pendekatan arus kas antara lain metode diskonto arus kas.

c. Pendekatan dividen antara lain  metode pertumbuhan dividen.

d. Pendekatan aktiva antara lain metode penilaian aktiva.

e. Pendekatan harga saham.

f. Pendekatan Economiv Value Added (EVA).



Menurut S. David Young (2001:29), market value adalah nilai dari

sebuah perusahaan yang didefinisikan sebagai total nilai klaim

terhadap asset yang dimiliki atau sama dengan nilai pasar dari

keseluruhan asset-asset yang dimiliki perusahaan atau lebih

mudahnya, market value merupakan penjumlahan dari nilai pasar dari

modal perusahaan dan nilai pasar dari hutang, market value mengukur

kekayaan yang diakumulasi perusahaan dari waktu ke waktu untuk

pemegang saham.

Nilai perusahaan sangat penting karena dengan nilai perusahaan

yang tinggi akan diikuti oleh tingginya kemakmuran pemegang saham

(Bringham Gapensi, 1996 dalam Rika Susanti, 2010: 32). Semakin

tinggi harga saham semakin tinggi pula nilai perusahaan. Nilai

perusahaan yang tinggi menjadi keinginan para pemilik perusahaan,

sebab dengan nilai yang tinggi menunjukan kemakmuran pemegang

saham juga tinggi. Kekayaan pemegang saham dan perusahaan

dipresentasikan  oleh  harga  pasar  dari  saham  yang  merupakan

cerminan dari keputusan investasi, pendanaan (financing), dan

manajemen asset.

Menurut Andri dan Hanung (2007) dalam Nica Febrina (2010: 5)

nilai perusahaan adalah nilai jual perusahaan atau nilai tumbuh bagi

pemegang saham, nilai perusahaan akan tercermin dari harga pasar

sahamnya.



Nilai perusahaan menurut Rika dan Islahudin (2008: 7)

didefinisikan sebagai nilai pasar. Nilai perusahaan dapat memberikan

kemakmuran pemegang saham secara maksimum apabila harga saham

perusahaan meningkat. Semakin tinggi harga saham, maka makin

tinggi kemakmuran pemegang saham. Untuk mencapai nilai

perusahaan umumnya para pemodal menyerahkan pengelolaannya

kepada para profesional. Para profesional diposisikan sebagai manajer

ataupun komisaris.

Menurut Vinola Herawati (2008: 7) salah satu alternatif yang

digunakan dalam menilai nilai perusahaan adalah dengan

menggunakan Tobin’s Q. Rasio ini dikembangkan oleh Profesor

James Tobin (1967). Rasio ini merupakan konsep yang berharga

karena menunjukkan estimasi pasar keuangan saat ini tentang nilai

hasil pengembalian dari setiap dolar investasi inkremental. Jika

Tobin’s Q diatas satu, ini menunjukkan bahwa investasi dalam aktiva

menghasilkan laba yang memberikan nilai yang lebih tinggi daripada

pengeluaran investasi, hal ini akan merangsang investasi baru. Jika

Tobin’s Q di bawah satu, investasi dalam aktiva tidaklah menarik.

Jadi Tobin’s Q merupakan  ukuran  yang lebih teliti  tentang seberapa

efektif manajemen memanfaatkan sumber-sumber daya ekonomis

dalam kekuasaannya.

Nilai perusahaan pada dasarnya diukur dari beberapa aspek salah

satunya adalah harga pasar saham perusahaan, karena harga pasar



saham perusahaan mencerminkan penilaian investor  atas

keseluruhan   ekuitas   yang   dimiliki (Wahyudi dan Pawestri, 2006).

Rasio-rasio  keuangan  digunakan  investor untuk  mengetahui

nilai  pasar perusahaan. Rasio tersebut dapat memberikan indikasi

bagi manajemen mengenai penilaian investor terhadap kinerja

perusahaan di masa lampau dan prospeknya dimasa depan. Ada

beberapa rasio untuk mengukur nilai pasar perusahaan, salah satunya

Tobin’s  Q.  Rasio  ini  dinilai  bisa  memberikan  informasi  paling

baik, karena dalam Tobin’s Q memasukkan semua unsur utang dan

modal saham perusahaan, tidak hanya saham biasa saja dan tidak

hanya ekuitas perusahaan yang dimasukkan namun seluruh asset

perusahaan. Dengan memasukkan seluruh asset perusahaan berarti

perusahaan tidak hanya terfokus pada satu tipe investor saja yaitu

investor dalam bentuk saham namun juga untuk kreditur karena

sumber pembiayaan operasional perusahaan bukan hanya dari

ekuitasnya saja tetapi juga dari pinjaman yang diberikan oleh kreditur

(Sukamulja, 2004 dalam Wien Ika Permanasari, 2010). Jadi semakin

besar nilai Tobin’s Q menunjukkan bahwa perusahaan memiliki

prospek pertumbuhan yang baik.

Hal ini dapat terjadi karena semakin besar nilai pasar asset

perusahaan dibandingkan dengan nilai buku asset perusahaan maka

semakin besar kerelaan investor untuk mengeluarkan pengorbanan



yang lebih untuk memiliki perusahaan tersebut (Sukamulja, 2004

dalam Wien Ika Permanasari, 2010: 25).

Dalam perspektif teori agensi, agen yang risk adverse dan

cenderung mementingkan dirinya sendiri akan mengalokasikan

resources (berinvestasi) dari investasi yang tidak meningkatkan nilai

perusahaan ke alternatif investasi yang lebih menguntungkan.

Permasalahan agensi akan mengindikasikan bahwa nilai perusahaan

akan naik apabila   pemilik perusahaan bisa mengendalikan perilaku

manajemen agar tidak menghamburkan resources perusahaan, baik

dalam bentuk investasi yang tidak layak maupun dalam bentuk

shirking.

Perusahaan akan mengungkapkan suatu informasi jika informasi

tersebut dapat meningkatkan nilai perusahaan. Perusahaan dapat

menggunakan informasi tanggung  jawab  sosial  sebagai  keunggulan

kompetitif  perusahaan.  Perusahaan yang memiliki kinerja lingkungan

dan sosial yang baik akan direspon positif oleh investor melalui

peningkatan harga saham. Apabila perusahaan memiliki kinerja

lingkungan dan sosial yang buruk maka akan muncul keraguan dari

investor sehingga   direspon   negatif   melalui   penurunan   harga

saham (Almilia dan Wijayanto, 2007 dalam Ni Wayan Rustiarini,

2010: 4-5).



2. Metode Persediaan Rata-Rata Tertimbang, Perputaran

Persediaan dan Tax Avoidance

2.1 Metode Persediaan Rata-Rata Tertimbang

Metode Persediaan Rata-Rata Tertimbang merupakan salah

satu metode yang terdapat pada arus biaya persediaan. Metode arus

biaya persediaan adalah kebijakan pengukuran yang digunakan

sebagai media kontrak antar economic agent yang berkaitan dengan

persediaan. Pemilihan metode arus biaya persediaan akan berdampak

pada laba perusahaan. Perubahan metode arus biaya persediaan dapat

mengakibatkan redistribusi kekayaan antara perusahaan dan

pemerintah (Bambang Sudaryono dan Hilda: 2007, 61).

Metode yang digunakan untuk menilai persediaan,

berdasarkan aliran biaya dapat dikelompokkan pada: (1) first-in, first

out, (2) last-in, first ou,t dan (3) biaya rata-rata (average cost)

(Weygandt, Kieso & Kimmel, 2008). Tetapi dengan adanya

perubahan pada Pernyataan Standar Akuntansi Keuangan No 14

(2012: 8) mengenai Persediaan yang mengadopsi IAS no 2, maka

metode pencatatan biaya yang diperkenankan adalah :

1.) First In First Out (FIFO) atau masuk pertama keluar

pertama, mengasumsikan bahwa barang yang pertama kali dibeli

adalah barang yang pertama kali dijual. FIFO bahkan paralel dengan

arus fisik aktual persediaan barang dagang karena umumnya

merupakan praktek bisnis yang sehat untuk menjual pertama kali



barang yang dibeli lebih dulu. Dengan metode FIFO, harga pokok

barang yang lebih dulu dibeli  merupakan biaya yang pertama kali

diakui sebagai harga pokok penjualan. Biaya persediaan akhir

ditentukan dengan pembelian paling akhir dan dihitung ke belakang

setelah seluruh unit persediaan dihitung biayanya.

2.) Biaya rata-rata tertimbang (Average) mengasumsikan

bahwa barang yang tersedia untuk dijual memiliki biaya per unit

yang sama (rata-rata). Pada umumnya barang yang dijual identik.

Harga pokok barang yang tersedia untuk dijual dialokasikan pada

dasar rata-rata biaya tertimbang per unit. Biaya rata-rata tertimbang

per unit kemudian diterapkan pada unit yang tersedia. Penggunaan

metode-metode arus biaya persediaan di atas berpengaruh terhadap

penentuan harga pokok barang yang tersedia dijual dan jumlah

persediaan akhir. Dalam periode di mana terdapat kenaikan harga,

metode FIFO menghasilkan laba bersih yang lebih besar. Hal ini

terjadi karena biaya-biaya yang dicocokkan dengan pendapatan

merupakan biaya unit yang lebih rendah dari unit yang pertama kali

dibeli. Menggunakan metode rata-rata tertimbang menghasilkan laba

yang lebih rendah dari metode FIFO. Hal ini terjadi karena biaya-

biaya yang dicocokkan dengan pendapatan merupakan biaya unit

rata-rata yang mengkombinasikan biaya tinggi dan rendah dan

menghasilkan biaya rata-rata.



Dalam pernyataan Undang-Undang Perpajakan No. 10 tahun

1994 pasal 10 ayat 6 hanya memperbolehkan wajib pajak untuk

memilih FIFO dan Rata-rata tertimbang. Sedangkan PSAK No.14

dalam pemilihan metode akuntansi persediaan di Indonesia

diberlakukan tiga metode akuntansi persediaan, yaitu metode first in

first out (FIFO), last in first out (LIFO), dan metode rata-rata

tertimbang. Kedua pernyataan ini menyiratkan bahwa perusahaan

diberi kebebasan untuk memilih salah satu metode arus biaya

persediaan yang diperkenankan. Masing-masing metode arus biaya

mempunyai karakteristik sendiri serta mempunyai dampak ekonomi

yang berbeda-beda. Dengan adanya perbedaan antara peraturan

perpajakan dan PSAK No.14, maka metode rata-rata tertimbang

menjadi solusi bagi perusahaan yang go public untuk menghasilkan

laba yang relatif stabil pada kondisi harga yang berubah atau inflasi,

sehingga dapat dikatakan bahwa investor lebih menyukai

penggunaan metode akuntansi persediaan rata-rata tertimbang

dibanding metode LIFO (Henry Kurniawan Wiryadi dan Supatmi,

2007).

Metode akuntansi persediaan rata-rata dan FIFO mempunyai

kedekatan hasil, bahkan secara teoretis metode rata-rata mirip

dengan metode FIFO. Namun demikian, dari perusahaan-perusahaan

yang diteliti, menurut Abdullah (1999, dalam Annisa, 2004)

mendapatkan sebanyak 78% perusahaan manufaktur di Indonesia



menggunakan metode akuntansi persediaan rata-rata dan 22%

perusahaan yang menggunakan metode FIFO. Perbedaan penerapan

metode akuntansi persediaan ini menimbulkan dugaan bahwa

dampak dari metode tersebut berbeda bahkan informasi yang

dihasilkan (laporan keuangan) dari perbedaan metode akuntansi

tersebut juga berbeda.

Menurut Ikatan Akuntan Indonesia dalm Standar Akuntansi

Keuangan Per 1 Oktober 2004 (2004: Paragraf 21) formula FIFO

mengasumsikan bahwa barang dalam persediaan yang pertama dibeli

akan dijual atau digunakan terlebih dahulu sehingga yang tertinggal

dalam persediaan akhir adalah barang yang dibeli atau diproduksi

kemudian. Persediaan akhir dilaporakan dengan nilai menurut harga

pokok yang paling baru atau harga pokok yang amat dekat dengan

nilai berjalan persediaan pada tanggal neraca. Metode akan

mencerminkan perputaran persediaan yang sesungguhnya.

Kelemahannya FIFO adalah mencerminkan nilai persediaan akhir

yang tidak up-to-date, karena dinilai dengan harga satuan per unit

pembelian yang pertama masuk, yang tidak memberikan arti saat ini

apabila harga satuannya meningkat tajam.

Metode Rata-rata tertimbang menggunakan suatu harga

pokok tunggal yang akan digunakan untuk menghitung harga pokok

barang yang dijual atau barang yang masih ada dalam persediaan

atau dapat diasumsikan bahwa biaya setiap barang ditentukan



berdasarkan biaya rata-rata tertimbang dari barang serupa pada awal

periode dan biaya barang serupa yang dibeli atau diproduksi selama

periode. Harga pokok persediaan didapat dengan membagi harga

pokok barang yang dapat dijual (harga pokok persediaan awal

ditambah pembeliaan) dengan jumlah unit tersedia untuk dijual

(Bambang Sudaryono dan Hilda: 2007,62). Tidak seperti metode

persediaan lainnya, metode ini mudah diaplikasikan, objektif,

memberikan harga pokok yang sama untuk barang yang sama

memiliki kegunaan yang sama, dan tidak memberi peluang

terjadinya manipulasi laba (Bambang Sudaryono dan Hilda:

2007,62). Pendekatan dengan metode rata-rata tertimbang menurut

Ali dan Hartono (2000, dalam Annisa, 2004) merupakan suatu

pendekatan yang realistis dan pararel dengan arus barang, khususnya

jika unit-unit ternyata bercampur-campur.

Menurut Kieso, Weygandt dan Warfield (2011:422), yaitu:

“Companies often use average cost methods for practical

rather than conceptual reasons, These methods are simple to apply

and objective. They are not as subject to income manipulation as

same of the other inventory pricing methods. In addition

proponents of the average cost methods reason that measuring a

specific physical flow of inventory is often impossible. Therefore,

it is better to cost items on an average-price basis. This argument is

particularly persuasive when dealing with similar inventory items.”



Penjelasan kutipan diatas adalah:

Perusahaan sering menggunakan metode biaya rata-rata

untuk alasan praktis daripada konseptual, metode ini sederhana

untuk menerapkan dan obyektif.  Mereka tidak tunduk pada

manipulasi penghasilan yang sama metode harga persediaan

lainnya. Alasan lain menggunakan metode biaya rata-rata bahwa

mengukur aliran fisik tertentu dari persediaan sering tidak mungkin.

Oleh karena itu, lebih baik untuk biaya barang secara harga rata-rata.

Argumen ini sangat persuasif ketika berhadapan dengan barang

persediaan yang sama.

2.2 Perputaran Persediaan

Perputaran persediaan menunjukkan berapa kali jumlah

persediaan barang dagangan diganti dalam satu tahun. Tingkat

perputasran persediaan mengukur perusahaan dalam memutar barang

dagangannya, dan menunjukkan pengaruh antara barang yang

diperlukan untuk mengimbangi tingkat penjualan yang ditentukan.

Menurut Jumingan (2006:128), menerangkan bahwa:  “Perputaran

persediaan (inventory turnover) menunjukkan berapa kali barang

dijual dan diadakan kembali selama satu periode akuntansi”.

Perputaran persediaan dihitung dengan, harga pokok penjualan

dibagi rata-rata persediaan.



Inventory turnover adalah rasio efisiensi yang dihitung

dengan membagi biaya barang yang terjual (cost of good sold)

dengan inventory (Ang, 1997). Rasio inventory turnover

menunjukkan seberapa efisien perusahaan mengatur inventorynya,

yaitu dengan menunjukkan berapa kali turnover inventory selama

satu tahun. Jenis rasio ini sangat bergantung pada jenis industri di

mana perusahaan berada. Sebagai contoh, toko penjual makanan

akan mempunyai tingkat turnover yang jauh lebih tinggi daripada

pabrik pembuat pesawat terbang. Sama seperi rasio-rasio yang lain,

adalah penting untuk membandingkan rasio ini dengan rasio dari

perusahaan-perusahaan yang lain dalam industri yang sama (Ang,

1997).

Menurut Satono (1999, p45) “Persediaan adalah barang-

barang atau bahan yang masih tersisa, atau barang-barang yang akan

segera dijual, digunakan atau diproses dalam periode normal

perusahaan”. Sifat dan wujud persediaan sangat bervariasi

tergantung sifat, jenis dan bidang usaha perusahaan.

Persediaan barang jadi yang cukup akan memberikan

fleksibelitas bagi perusahaan untuk skedul produksi dan

pemasarannya. Bagian produksi tidak dipaksa untuk memproduksi

dalam jumlah yang besar secara cepat karena adanya persediaan

barang jadi ini. Persediaan barang jadi yang cukup juga dapat

menjamin efektifitas kegiatan pemasaran, karena apabila persediaan



kurang maka bisa jadi perusahaan akan kehilangan kesempatan

untuk merebut pasar. Dengan persediaan yang cukup perusahaan

dapat memnuhi peranan dengan cepat. Namun demikian persediaan

yang besar itu juga membawa konsekuensi berupa biaya yang timbul

adalah keusangan atau persediaan. Faktor-faktor yang

mempengaruhi perputaran, yaitu tingkat penjualan, sifat teknis dan

lainnya proses produksi, dan daya tahan produk akhir (faktor mode).

2.3 Tax Avoidance

Tax Avoidance adalah rekayasa “tax affairs” yang masih

tetap berada dalam bingkai ketentuan perpajakan (Erly Suandy,

2001:8). Salah satu kendala dalam rangka optimalisasi penerimaan

pajak adalah adanya penghindaran pajak (tax avoidance).

Penghindaran pajak  adalah hambatan-hambatan yang terjadi dalam

pemungutan pajak sehingga mengakibatkan berkurangnya

penerimaan kas negara.

Dalam teori tradisional tax avoidance dianggap sebagai

aktivitas untuk mentransfer kesejahteraan dari Negara kepada

pemegang saham (Kim et. Al.; 2011), oleh karena itu pemisahan atas

kepemilikan dan control menjadi hal yang penting. Dalam teori

keagenan, tax avoidance dapat memfasilitasi kesempatan manjerial

untuk melakukan manipulasi laba atau penempatan sumber daya

yang tidak sesuai. Hanlon (2010) mendeinisikan tax avoidance



sebagai pengurangan pajak secara eksplisit, dimana tax avoidance

merupakan rangkai aktivitas perencanaan pajak. Tax Avoidance

dapat menggambarkan suatu bentuk permasalahan keagenan, dimana

keputusan manajer dapat mencerminkan adanya kepentingan pribadi

manajer dengan adanya pemisahan kepemilikan dan pemisahan

pengendalian. Aktivitas tax avoidance memunculkan kesempatan

bagi manajemen dalam melakukan aktivitas yang didisain untuk

menutupi berita buruk atau menyesatkan investor (Desai dan

Dharmapala, 2006).

Secara bisnis, perencanaan  pajak adalah beralasan, karena

untuk memperoleh keuntungan pengusaha dalam mengahadapi

banyak resiko yang harus diminimisasi dan aspek perpajakan adalah

salah satunya karena pada dasarnya pajak dalah merupakan

tambahan biaya bagi perusahaan. Perencanaan pajak mencakup

usaha-usaha untuk melakukan proteksi agar perusahaan terhindar

atau paling tidak meminimalisasi kemungkinan koreksi pajak pada

masa-masa yang akan datang. Perencanaan pajak dikenal dua istilah

yang sangat populer seperti diuraikan di bawah ini. (Wirawan B.

Ilyas dan Diaz Priantara 2013:16):

1. Tax Avoidance

Tax Avoidance (penghindaran pajak) adalah manipulasi

secara legal yang masih sesuai dengan ketentuan perundang-

undangan perpajakan untuk memperkecil jumlah pajak terutang



(Barr NA, 1977) atau pengaturan suatu peristiwa untuk

meminimumkan pajak sesuai dengan ketentuan perpajakan.

Dengan demikian, penghindaran pajak yaitu usaha-usaha yang

masih termasuk untuk memperkecil di dalam konteks dan tidak

melanggar peraturan-peraturan pajak yang berlaku untuk

memperkecil jumlah pajak yang terutang dari tahun sekarang ke

tahun-tahun yang akan datang sehingga dapat membantu

memperbaiki arus kas dan keuntungan wajib pajak.

Tax avoidance menurut peraturan pajak tidak dilarang

meskipun seringkali mendapat sorotan yang kurang baik karena

dianggap memiliki konotasi negatif ataupun dianggap kurang

nasionalis. Tax avoidance dilakukan dengan cara-cara atau

strategi perencanaan pajak dan memanfaatkan celah atau

kelemahan ketentuan perpajakan. Tax Avoidance yang sehat

dilakukan melalui starategi perencanaan pajak yang tepat.

Tujuan Perencanaan Pajak adalah merekayasa agar beban pajak

(Tax Burden) serendah mungkin dengan memanfaatkan

peraturan yang ada tanpa melanggarnya. Tax planning sama

dengan tax avoidance karena secara hakikat ekonomis kedua-

duanya berusaha untuk memaksimalkan penghasilan setelah

pajak (after tax return) karena pajak merupakan unsur

pengurang laba yang tersedia untuk dibagiakan kepada

pemegang saham maupun diinvestasikan kembali.



2. Tax evasion

Tax evasion (penggelapan atau pengelakan pajak) adalah

manipulasi secara illegal atas penghasilannya untuk

memperkecil jumlah pajak terutang (Barr NA, 1997) atau

penyeludupan pajak yang melanggar undang-undang pajak

(Anderson, dalam Zain, 2003). Dengan demikian, pengelakan

pajak yaitu usaha-usha untuk memperkecil jumlah pajak yang

terutang  atau menggeser beban pajak yang terutang dengan

melanggar ketentuan-ketentuan pajak yang berlaku. Tax evasion

merupakan pelanggaran dalam bidang perpajakn sehingga tidak

boleh dilakukan, karena pelaku tax evasion dapat dikenakan

sanksi administratif maupun sanksi pidana.

Untuk meminimumkan kewajiban pajak dapat dilakukan

dengan berbagai cara, baik yang masih memenuhi ketentuan

perpajakan (lawful) maupun yang melanggar peraturan perpajakan

(unlawful). Istilah yang sering digunakan adalah tax avoidance dan

tax evasion. Pengertian dari kedua istilah tersebut adalah sebagai

berikut (Erly Suandy 2013:7):

1. Penghindaran pajak adalah istilah yang digunakan untuk

menggambarkan pengaturan hukum urusan wajib pajak

sehingga dapat mengurangi kewajiban  pajaknya. Ini sering

merendahkan, misalnya adalah digunakan dalam

menggambarkan penghindaran dicapai dengan pengaturan



buatan urusan pribadi atau bisnis untuk mengambil keuntungan

dari celah, ambiguitas, anomali atau kekurangan lain dari hukum

pajak. Legislasi yang dirancang untuk melawan penghindaran

telah menjadi lebih umum dan sering melibatkan penyediaan

sangat kompleks (Lyons Susan M., 1996).

2. Penggelapan pajak adalah pengurangan pajak dengan cara

ilegal. Perbedaan, bagaimanapun, tidak selalu mudah. Beberapa

contoh skema penghindaran pajak termasuk mencari asset dalam

yuridiksi lepas pantai, menunda pemulangan keuntungan dapat

di pajak rendah yuridis asing, memastikan bahwa keuntungan

adalah modal daripada pendapatan wajib pajak lain dengan tarif

pajak marjinal rendah dan mengambil keuntungan dari insentif

pajak (Lyons Susan M., 1996).

Penghindaran pajak dapat terjadi di dalam bunyi ketentuan

atau tertulis di undang-undang dan berada dalam jiwa dari undang-

undang atau dapat juga terjadi dalam bunyi ketentuan undang-

undang tetapi berlawanan dengan jiwa undang-undang. Komite

urusan fiskal dari Organization for Economic Cooperation and

Development (OECD) menyebutkan tiga karakter penghindaran

pajak sebagai berikut, (Erly Suandy 2013:7):

1. Adanya unsur artifisial di mana berbagai pengaturab seolah-olah

terdapat di dalamnya padahal tidak, dan ini dilakukan karena

ketiadaan faktor pajak.



2. Skema semacam ini sering memanfaatkan loophles dari undang-

undang atau menerapkan ketentuan-ketentuan legal untuk

berbagai tujuan, padahal bukan itu yang sebetulnya

dimaksudkan oleh pembuat undang-undang.

3. Kerahasiaan juga sebagai bentuk dari skema ini di mana

umumnya para konsultan menunjukkan alat atau cara untuk

melakukan penghindaran pajak dengan syarat wajib pajak

serahasia mungkin (Council of Executive Secretaries of Tax

Organizations, 1991).

Penghindaran pajak adalah wajib pajak tidak secara jelas

melanggar undang-undang sekalipun kadang-kadang dengan jelas

menafsirkan undang-undang tidak sesuai dengan maksud dan tujuan

pembuat undang-undang pembuat undang-undang. Penghindaran

pajak dilakukan dengan 3 cara, yaitu sebagai berikut: (Thomas

Sumarsan 2013:116)

1. Menahan diri

Yang dimaksud dengan menahan diri yaitu Wajib Pajak

tidak melakukan sesuatu yang bisa dikenai pajak. Contoh: tidak

menggunakan mobil mewah, untuk menghindari pengenaan

Pajak Penjualan Barang Mewah; tidak konsumsi minuman keras

(alkohol) untuk meghindari pengenaan cukai alkohol.



2. Lokasi terpencil

Memindahkan lokasi usaha atau domisili dari lokasi yang

tarif pajaknya tinggi ke lokasi yang tarif pajaknya rendah.

Contoh: Di Indonesia, diberikan keringanan bagi investor ingin

menanamkan modalnya di Indonesia bagian  timur. Oleh karena

itu, pengusaha yang baru membuka usaha, atau perusahaan yang

akan membuka cabang baru, mereka membuka cabang baru di

tempat yang tarif pajaknya lebih rendah.

Jadi, berdasarkan uraian di atas, contoh penghindaran pajak

secara illegal adalah sebagai berikut.

a. Mengecilkan angka penjualan pada laporan SPT (Surat

Pemberitahuan) pajak dari angka penjualan yang

sebenarnya. Misalnya perusahaan yang memiliki penjualan

sebesar Rp 500 miliar, tetapi dalam laporan keuangan fiskal

dan SPT (Surat Pemberitahuan) Tahunan Pajak Penghasilan

perusahaan hanya menunjukkan Rp 3 (tiga) miliar.

b. Melakukan transaksi ekspor fiktif. Perusahaan yang

melakukan transaksi ekspor fiktif adalah untuk penarikan

jaminan fasilitas Kemudahan Impor Tujuan Ekspor (KITE)

dan memanipulasi pembayaran pajak pertambahan nilai

(PPN).

c. Menggelembungkan biaya perusahaan untuk mengecilkan

laba bersih fiskal sehingga pembayaran pajak yang kecil.



d. Memalsukan dokumen transaksi perusahaan, misalnya

faktur penjualan, faktur pembelian, bukti biaya, rekening

Koran, dan dokumen lainnya.

e. Menyampaikan Surat Pemberitahuan (SPT) tidak tepat pada

waktunya.

f. Melakukan pembayaran pajak tidak tepat pada waktunya.

g. Menyampaikan pelaporan penghasilan dan pengurangannya

secara tidak lengkap dan tidak benar.

h. Tidak menyelenggarakan pembukuan.

i. Membuat faktur pajak fiktif.

j. Menggunakan faktur pajak fiktif.

k. Tidak menyetorkan dan melaporkan pajak penghasilan yang

telah dipotong, baik dari karyawan maupun dari pemberi

jasa ke kas Negara.

l. Tidak memberikan peminjaman dokumen pada saat

pemeriksaan pajak.

m. Memberikan suap kepada aparat perpajakan.

Dilakukannya tax avoidance sebagai suatu kesalaham

alokasi yang terjadi di dunia nyata, kemerosotan etika bisnis,

hilangnya indenpendensi auditor dan interfensi dengan suatu sistem

kendali. Jika tujuan dari tax planning ini adalah merekayasa agar

beban pajak dapat ditekan serendah mungkin dengan memanfaatkan



peraturan yang ada tetapi berbeda dengan tujuan pembuatan undang-

undang, maka perencanaan pajak di sini sama dengan unacceptable

tax avoidance, karena secara hakikat ekonomi keduanya berusaha

untuk memaksimalkan penghasilan setelah pajak, karena pajak

merupakan unsur pengurang laba (Lumbantoruan dalam Suandy,

2008:6).

Umumnya perencanaan pajak merujuk pada proses

merekayasa usaha dan transaksi wajib pajak supaya utang pajak

berada dalam jumlah minimal (Suandy, 2008). Biasanya perusahaan

melakukan strategi-strategi atau cara-cara yang legal sesuai dengan

aturan undang-undang yang berlaku, namun dilakukan dengan

memanfaatkan hal-hal yang sifatnya ambigu dalam undang-undang

sehingga dalam hal ini wajib pajak memanfaatkan celah-celah yang

ditimbulkan oleh adanya ambiguitas dalam undang-undang

perpajakan (Suandy: 2008).

Sebagai perusahaan yang berorientasi laba, sudah tentu

suatu perusahaan domestik maupun perusahaan multinasional

berusaha meminimalkan beban pajak dengan cara memanfaatkan

kelemahan sistem ketentuan pajak dari suatu negara. Menurut

Rohatgi dalam Bambang (2009), di banyak Negara skema

penghindaran pajak dapat dibedakan menjadi:

1. Penghindaran pajak yang diperkenankan (acceptable tax

avoidance).



2. Penghindaran pajak yang tidak diperkenankan (unacceptable tax

avoidance).

Antara suatu negara dengan negara lain bisa jadi saling

berbeda pandangannya tentang skema apa saja yang dapat

dikategorikan sebagai acceptable tax avoidance atau unacceptable

tax avoidance ( Inside Tax Edisi September 2007). Dengan

demikian, bisa saja suatu skema penghindaran pajak tertentu di suatu

negara dikatakan sebagai penghindaran pajak yang tidak

diperkenankan, tetapi di negara lain dikatakan sebagai penghindaran

pajak yang diperkenankan. Istilah lain yang sering dipergunakan

untuk menyatakan penghindaran pajak yang tidak diperkenankan

adalah aggressive tax planning dan istilah untuk penghindaran pajak

yang diperkenankan adalah defensive tax planning.

Dalam menghadapi skema-skema unacceptable tax

avoidance atau aggressive tax planning seperti tersebut di atas,

umumnya suatu negara menerbitkan ketentuan pencegahan

penghindaran pajak yang diatur dalam peraturan perundang-

undangan perpajakan sebagai berikut ini:

1. Specific Anti Avoidance Rule (SAAR), yaitu ketentuan anti

penghindaran pajak atas transaksi seperti (i) transfer pricing,

(ii) thin capitalization, (iii) treaty shopping, dan (iv) controlled

foreign corporation(CFC).



2. General Anti Avoidance Rule (GAAR), yaitu ketentuan anti

penghindaran pajak untuk mencegah transaksi yang semata-

mata dilakukan oleh wajib pajak yang semata-mata untuk tujuan

penghindaran pajak atau transaksi yang tidak mempunyai

substansi  bisnis.

Di banyak negara, seperti di Israel dan Kanada, telah

membuat suatu ketentuan untuk menangkal praktik unacceptable tax

avoidance atau aggressive tax planning yang dilakukan oleh Wajib

Pajak. Hal ini disebabkan karena tax planning yang dilakukan oleh

Wajib Pajak tidak lagi bersifat defensive tax planning (Indrayagus

Slamet di Inside Tax Edisi September 2007)  lagi tetapi sudah

semakin offensive yaitu dengan membuat suatu transaksi semu yang

pada dasarnya tidak ada tujuan bisnisnya atau membuat suatu entitas

usaha di negara-negara yang dikategorikan sebagai tax haven

country.

Di Australia, skema-skema yang dapat dikategorikan

sebagai aggressive tax planning oleh Australian Taxation Office

(ATO) adalah sebagai berikut: (Rachel Tooma,  2006: 427).

1. Transaksi yang dibuat semata-mata untuk tujuan menghindari

pajak. Dengan kata lain transaksi tersebut tidak mempunyai

tujuan bisnis, kalaupun ada tujuan bisnisnya tetapi sangat tidak

signifikan.



2. Berusaha untuk mendapatkan fasiltas pajak yang sebenarnya

fasilitas pajak tersebut tidak ditujukan kepadanya.

3. Membuat transaksi yang berputar-putar yang akhirnya transaksi

tersebut akan kembali lagi kepadanya (round-robin flow of

funds).

4. Penggelembungan nilai aset untuk mendapatkan biaya

penyusutan yang besar di masa yang akan datang.

5. Memanfaatkan suatu entitas usaha di mana penghasilan yang

diterima oleh entitas usaha tersebut dikecualikan sebagai objek

pajak.

6. Transaksi bisnis yang melibatkan negara-negara yang

dikategorikan sebagai tax haven countries.

Dalam peraturan perundang-undangan perpajakan Indonesia

yang berlaku saat ini, belum ada definisi yang jelas mengenai tax

plannning, agresive tax planning, acceptable tax avoidance dan

unacceptable tax avoidance. Dengan demikian, dalam praktiknya

sering menimbulkan penafsiran yang berbeda antara wajib pajak dan

aparat pajak. Wajib Pajak dan aparat pajak tentu akan memberikan

penafsiran sendiri-sendiri yang menguntungkan mereka, sehingga

menimbulkan ketidakpastian hukum. Dari sudut pandang wajib

pajak, tentu akan berpendapat bahwa sepanjang skema penghindaran

pajak yang mereka lakukan tidak dilarang dalam peraturan



perundang-undangan perpajakan tentu sah-sah saja (legal). Hal ini

dimaksudkan untuk memberi kepastian hukum bagi Wajib Pajak.

Akan tetapi, di sisi lain, pemerintah tentu juga

berkepentingan bahwa jangan sampai suatu ketentuan perpajakan

disalah gunakan oleh wajib pajak untuk semata-mata tujuan

penghindaran pajak yang akan merugikan penerimaan negara. Oleh

karena itu, untuk kepastian hukum baik bagi wajib pajak maupun

bagi pemerintah, ketentuan tentang tax planning, tax avoidance, dan

anti tax avoidance yang berupa Specific Anti Avoidance Rule (SAAR)

maupun General Anti Avoidance Rule (GAAR) harus diatur secara

jelas dan rinci dalam ketentuan peraturan perundang-undangan

perpajakan, baik untuk ketentuan formalnya yaitu terkait dengan

sanksi, maupun dalam ketentuan materialnya

Beberapa resiko yang ditimbulkan oleh kegiatan tax

avoidance antara lain: denda, publisitas dan reputasi (Friese: 2006).

Sekat yang membatasi legal dan ilegalnya suatu tindakan

penghematan pajak dalam upaya tax planning masih sulit untuk

dibedakan (Bovi: 2005), sehingga diharapkan perusahaan lebih baik

mematuhi peraturan perpajakan dan tidak memanfaatkan ambiguitas

dari peraturan perpajakan untuk kebaikan perusahaan di masa yang

akan datang.



Tax Avoidance bukan pelanggaran undang-undang

pelanggaran undang-undang perpajakan karena usaha wajib pajak

untuk mengurangi, menghindari, meminimumkan atau

meringakankan beban pajak dilakukan dengan cara yang

dimungkinkan oleh Undang-Undang Pajak. Adapun cara tersebut

menurut Merks (2007) adalah a) memindahkan subjek pajak dan atau

objek pajak ke Negara-negara yang memberikan perlakuan pajak

khusus atau keringanan pajak (tax haven country) atas suatu  jenis

penghasilan (substantive tax planning), b) usaha penghindaran pajak

dengan mempertahankan substansi ekonomi dari transaksi melalui

pemilihan formal yang memberikan beban pajak yang paling rendah

(Formal tax planning), c) ketentuan Anti Avoidance atas transaksi

transfer pricing, thin capitalization, treaty shopping, dan controlled

foreign corporation (Specific Anti Avoidance Rule), serta transaksi

yang tidak mempunyai substansi bisnis (General Anti Avoidance

Rule).

Lim (2011) mendefinisikan tax avoidance sebagai

penghematan pajak yang timbul dengan memanfaatkan ketentuan

perpajakan yang dilakukan secara legal untuk meminimalkan

kewajiban pajak. Tax Avoidance merupakan bagian dari tax planning

yang dilakukan dengan tujuan meminimalkan pembayaran pajak.

Tax avoidance secara hukum pajak tidak dilarang meskipun

seringkali mendapatkan sorotan yang kurang baik dari kantor pajak



karena dianggap memiliki konotasi yang negatif. Selain tax

avoidance juga terdapat istilah tax aggressive dan tax sheltering.

Pengertian tax aggressive seperti yang diungkapkan oleh

Frank et al. (2009) merupakan tindakan yang bertujuan mengurangi

pendapatan kena pajak melalui perencanaan pajak. Tax aggressive

menggunakan metode yang diklasifikasikan atau tidak

diklasifikasikan sebagai tax evasion (penggelapan pajak), meskipun

tidak semua tindakan yang dilakukan melanggar aturan akan tetapi

metode yang digunakan oleh perusahaan membuat perusahaan

diasumsikan lebih agresif.

Tax avoidance dapat diukur dengan beberapa pengukuran.

Desai dan Dharmapala (2006), menggunakan total accruals untuk

memisahkan komponen book tax different yang disebabkan oleh

tujuan pajak dan manajemen laba. Sedangkan Lim (2011)

menggunakan discretionary accrual. Discretionary Accrual

merupakan proksi manajemen laba dengan pengukurannya

menggunakan formula dari Dechow et al. (1995). Lim (2011)

menggunakan discretionary accrual tersebut untuk memisahakan

komponen dari book tax different yang disebabkan oleh manajemen

laba untuk tujuan pajak.



B. Penelitian yang Relevan

Sebagai landasan dan acuan penelitian, peneliti menggunakan hasil

penelitian terdahulu yang telah teruji secara empiris sehingga dapat

memperkuat hasil penelitian ini. Penelitian tersebuat adalah penelitian-

penelitian yang berkaitan dengan batasan penggunaan metode persediaan

rata-rata tertimbang perputaran persediaan, tax avoidance dan market

value perusahaan.

Hasil penelitian tersebut terangkum dalam table review penelitian

terdahulu di Tabel 2.1.

Tabel 2.1

Penelitian Relevan

No. Peneliti &
Tahun

Judul Penelitian Persamaan Perbedaan Hasil Penelitian

1. Bambang
Sudaryono
dan Hilda.

Jurnal
Informasi,
Perpajakan,
Akuntansi dan
Keuangan
Publik.

Vol. 2, No. 1,
Januari 2007.
Hal. 59-77

Analisis Pengaruh
Penerapan Metode
Arus Biaya
Persediaan, Nilai
Persediaan dan
Gross Profit
Margin Terhadap
Market Value
Perusahaan
Manufaktur di
Bursa Efek
Jakarta.

Variabel Bebas:
Metode Persediaan.

Variabel Terikat:
Market Value
Perusahaan.

Variabel Bebas:
Nilai Persediaan
dan Gross Profit
Margin.

1) Pengujian statistik
terhadap variabel
metode persediaan
menunjukkan tidak
terdapat pengaruh
yang signifikan antara
metode persediaan
terhadap market value
perusahaan.

2) Pengujian statistik
terhadap variabel nilai
persediaan
menunjukkan terdapat
pengaruh yang
signifikan antara nilai
persediaan terhadap
market value
perusahaan.

3) Pengujian statistik
terhadap variabel



gross profit margin
menunjukkan tidak
terdapat pengaruh
yang signifikan antara
gross profit margin
terhadap market value
perusahaan.

2. Abubakar Arif
dan Resti
Jayeng
Ramadhanti.

Jurnal
Informasi,
Perpajakan,
Akuntansi dan
Keuangan
Publik.

Vol.4, No.1,
Januari 2009.

Hal. 01-16.

Analisis Pengaruh
Penerapan Metode
Arus Biaya
Persediaan, Nilai
Persediaan,
Perputaran
Persediaan dan
Gross Profit
Margin Terhadap
Market Value
Perusahaan
Manufaktur
Tahun 2003-2006.

Variabel  Bebas:
Metode Persediaan
dan Perputaran
Persediaan

Variabel Terikat:
Market Value
Perusahaan.

Variabel Bebas:
Nilai Persediaan
dan Gross Profit
Margin.

1) Pengujian statistik
terhadap variabel arus
biaya persediaan
menunjukkan tidak
terdapat pengaruh
yang signifikan antara
metode persediaan
terhadap market value
perusahaan.

2) Pengujian statistik
terhadap variabel nilai
persediaan
menunjukkan terdapat
pengaruh yang
signifikan antara nilai
persediaan terhadap
market value
perusahaan.

3) Pengujian statistik
terhadap variabel
perputaran persediaan
menunjukkan tidak
terdapat pengaruh
yang signifikan antara
perputaran persediaan
terhadap market value
perusahaan.

4) Pengujian statistik
terhadap variabel
gross profit margin
menunjukkan tidak
terdapat pengaruh
yang signifikan antara
gross profit margin
terhadap market value
perusahaan.

3. Tommy
Kurniasih dan
Maria M.
Ratna Sari.

Buletin Studi
Ekonomi.

Pengaruh Return
On Assets,
Leverage,
Corporate
Governance,
Ukuran
Perusahaan dan
Kompensasi Rugi

Variabel Tax
Avoidance

Variabel Return On
Assets, Leverage,
Corporate
Governance,
Ukuran Perusahaan
dan Kompensasi
Rugi Fiskal

1) Return On Assets
(ROA), Leverage,
Corporate
Governance, Ukuran
Perusahaan dan
Kompensasi Rugi
Fiskal berpengaruh
signifikan secara



Volume 18,
No.1, Februari
2013.

Fiskal Pada Tax
Avoidance

simultan terhadap
tax avoidance pada
perusahaan
manufaktur yang
terdaftar di BEI
periode 2007-2010.

2) Return On Assets
(ROA), Ukuran
Perusahaan dan
Kompensasi Rugi
Fiskal berpengaruh
signifikan secara
parsial terhadap tax
avoidance,
sedangkan Leverage
dan Corporate
Governance tidak
berpengaruh
signifikan secara
parsial  terhadap tax
avoidance pada
perusahaan
manufaktur yang
terdaftar di BEI
periode 2007-210.

4. Mihir A. Desai
Graduate
School of
Business
Administratio,
Harvard
University,
Boston, MA
02163
and
National
Bureau of
Economic
Research,
Cambridge,
MA 02138

Dhammika
Dharmapala
Department of
Economics,
University
of
Connecticut,
Storrs,
CT 06269–
1063

Earnings
Management,
Corporate Tax
Shelters,
And
Book–Tax
Alignment

Bahwa komponen

internal dan komponen

pengawasan pasar , dan

mengeksplorasi

hubungan masing-

masing dengan

penghindaran pajak .

Saya menemukan bahwa

kedua komponen

menanggung signifikan

hubungan negatif

terhadap penghindaran

pajak .



National Tax
Journal
Vol. LXIl,
No.1
March 2009

5. Mihir A Desai
Harvard
University and
NBER

Dhammika
Dharmapala
University
of Connectcut

Review
of Economics
and Statistics
Vol. 91: 537-
546 (Volume
publication
date: August
2009)
DOI:
10.1162/rest.9
1.3.537

Corporate Tax
Avoidance and
Firm Value

Corporate Tax
Avoidance

Firm Value Bahwa valuasi

penghindaran pajak

adalah fungsi

pemerintahan perusahaan

menunjukkan bahwa

penghindaran pajak dan

upaya manajerial untuk

mengalihkan nilai dari

pemegang saham dapat

terjalin.

C. Kerangka Pemikiran

Market value perusahaan dalam kaitannya dengan laporan

keuangan diuraikan oleh teori pasar efisien. Dalam pasar efisien,

harga-harga mencerminkan sepenuhnya  informasi  yang tersedia

(Belkaoui, 2004). Market value dari suatu perusahaan menyajikan

suatu  nilai yang melekat pada perusahaan tersebut  berdasarkan

pasar. Market value tersebut tercermin dari harga saham perusahaan

yang ditawarkan di pasar. Harga pasar dari perusahaan adalah

sesungguhnya mencerminkan  nilai  pasarnya  (Kam,  1990).

Saat tinggi rendahnya perputaran persediaan mempunyai efek yang

langsung terhadap besar kecilnya modal yang diinvestasikan dalam



inventory. Makin tinggi turnovernya, berarti makin cepat

perputarannya yang akan mengindikasikan pendapatan yang

dihasilkan melebihi harga pokok penjualan, yang tentunya akan

berpengaruh terhadap market value perusahaan. Menurut Jumingan

(2006:128) menjelaskan bahwa: “Perputaran Persediaan menunjukkan

barang dijual dan ditiadakan kembali satu periode’’.

Dalam teori keagenan, tax avoidance dapat memfasilitasi

kesempatan manajerial untuk melakukan manipulasi laba atau

penempatan sumber daya yang tidak sesuai. Desai dan Dharmapala

(2009), melakukan pengujian cross sectional, kepemilikan

instiusional mempengaruhi hubungan tax avoidance dengan nilai

perusahaan, dimana pada perusahaan dengan kepemilikan

institusional yang lebih kuat, tax avoidance mempengaruhi nilai

perusahaan. Hal ini menunjukkaan bahwa pengaruh shareholder

dalam tax avoidance perusahaan tergantung pada kemampuan

shareholder untuk mengontrol manajer.

Penelitian ini dilakukan dengan kerangka pikir secara parsial, agar

hasil dalam penelitian ini dapat membuktikan dan memfokuskan

dalam menguji pengaruh antar variabel dependen dengan variabel

independen.



Untuk lebih jelasnya, kerangka pikir yang digunakan dapat dilihat

di Gambar 2.2.

Gambar 2.2 Kerangka Pemikiran

D. Hipotesis Penelitian

Hipotesis merupakan pernyataan singkat yang disimpulkan dari

telaah pustaka, serta merupakan jawaban terhadap masalah yang diteliti.

Hipotesis ini akan memaparkan pengaruh metode persediaan rata-rata

tertimbang, perputaran persediaan dan tax avoidance terhadap market

value perusahaan.

1. Pengaruh Metode Persediaan Rata-Rata Tertimbang Terhadap

Market Value Perusahaan

Metode Persediaan akan mempengaruhi laba rugi perusahaan.

Metode rata-rata akan menghasilkan laba akuntansi yang cenderung

lebih kecil dibandingkan dengan metode yang lainnya karena metode

rata-rata menggabungkan seluruh price inflow (Anthony et al, 2000).

Namun jika investor-investor tersebut mengerti adanya pengaruh

dari penggunaan metode persediaan, akan menyebabkan adanya

perubahan investor. Selain itu, adanya saran pialang atau broker dan

Metode persediaan
rata-rata tertimbang

Perputaran Persediaan

Tax Avoidance

Market Value
Perusahaan



analisis saham juga memberikan kontribusi bagi persepsi investor,

karena biasanya para investor cenderung untuk melihat atau menuruti

nasehat-nasehat para analisis saham.

Adanya persepsi investor yang baik dari suatu perusahaan untuk

masa depan investasi sahamnya, maka akan dapat menyebabkan

permintaan terhadap saham perusahaan tersebut akan meningkat, dan

secara otomatis harga saham akan naik. Begitu juga sebaliknya jika

persepsi investor jelek terhadap suatu perusahaan, maka akan

menyebabkan permintaan saham terhadap perusahaan tersebut akan

turun, dan dapat menyebabkan harga saham perusahaan tersebut akan

turun. Turun atau naiknya harga saham dalam suatu perusahaan akan

mempengaruhi market value perusahaan tersebut.

Sedangkan pendekatan dengan metode rata-rata menurut Ali dan

Hartono (2000, dalam Annisa, 2004) pendekatan ini merupakan suatu

pendekatan yang realistis dan pararel dengan arus barang, khususnya

jika unit-unit ternyata bercampur-campur. Metode harga perolehan

rata-rata menetapkan harga persediaan berdasarkan harga perolehan

rata-rata atas semua barang yang sama yang tersedia selama satu

periode.

Berdasarkan penjabaran tersebut hipotesis yang diajukan adalah

H1 : Metode persediaan rata-rata tertimbang berpengaruh

terhadap market value perusahaan.



2. Pengaruh Perputaran Persediaan Terhadap Market Value

Perusahaan

Perusahaan Manufaktur selalu berpengaruh dengan persediaan

karena kegiatan produksi yang dilakukan selalu membutuhkan adanya

barang yang siap untuk digunakan sepanjang waktu. Tinggi rendahnya

perputaran persediaan mempunyai efek yang langsung terhadap besar

kecilnya modal yang diinvestasikan dalam inventory. Makin tinggi

turnovernya, berarti makin cepat perputarannya. Dari segi biaya,

apabila perputaran persediaan semakin lama, maka persediaan

menumpuk, sehingga biaya yang dikeluarkan untuk pemeliharaan

semakin tinggi hal ini akan memperkecil laba.

Berdasarkan penjabaran tersebut hipotesis yang diajukan adalah

H2 : Perputaran persediaan berpengaruh terhadap market value

perusahaan.

3. Pengaruh Tax Avoidance Terhadap Market Value Perusahaan

Desai dan Dharmapala. (2009),  melakukan  pengujian cross

sectional, kepemilikan insitiusional mempengaruhi hubungan tax

avoidance dengan nilai perusahaan, dimana pada perusahaan dengan

kepemilikan institusional yang lebih kuat, tax avoidance

mempengaruhi nilai perusahaan. Hal ini menunjukkan bahwa pengaruh

shareholder dalam tax avoidance perusahaan tergantung pada

kemampuan shareholder untuk mengontrol manajer. Wang (2010),



membuktikan transparansi perusahaan berpengaruh terhadap tindakan

tax avoidance yang dilakukan. Hasil dari penelitian ini menemukan

bahwa tax avoidance mempengaruhi nilai perusahaan, terutama untuk

perusahaan yang transparansinya baik.

Penelitian yang dilakukan oleh Tang  (2008)  membuktikan bahwa

book tax differences berpengaruh negatif dengan earning perusahaan

di periode berikutnya. Penelitian lain mengenai book tax differences

dilakukan oleh Michelle Hanlon (2005) dengan  menggunakan book

tax differences sebagai salah satu indikator dalam memprediksi dan

presistensi earning, cash flow dan accrual di masa yang akan datang.

Hasil dari penelitian ini membuktikan bahwa perusahaan dengan book

tax differences yang besar cenderung kurang persisten earningnya

dibanding dengan perusahaan dengan book tax differences yang lebih

kecil.

Hanlon dan Slemrod (2009)  menguji bagaimana reaksi pasar atas

tindakan tax avoidance yang dilakukan oleh perusahaan. Hanlon dan

Slemrod menyatakan bahwa tindakan tax aggressiveness dapat

meningkatkan atau menurunkan nilai saham perusahaan. Jika tax

aggressiveness dipandang sebagai  upaya untuk melakukan tax

planning dan efisiensi pajak, maka pengaruhnya positif terhadap nilai

perusahaan. Namun jika dipandang sebagai tindakan non complience,

justru akan meningkatkan risiko sehingga mengurangi nilai



perusahaan. Hasil dari penelitian ini  membuktikan bahwa pasar

bereaksi negatif terhadap tindakan tax avoidance.

Perusahaan dengan pengungkapan pajak yang lebih luas

mendapatkan reaksi yang lebih baik. Ketika perusahaan tersebut

memiliki good corporate governance yang lebih baik maka reaksinya

akan menjadi lebih positif. Perusahaan yang lebih berorientasi pada

konsumen reaksinya lebih negatif dan reaksi tersebut tergantung pada

persepsi investor atas level penghindaran pajak perusahaan. Hanlon

dan Slemrod (2009) menyimpulkan bahwa market positively surpraise.

Penelitian di Indonesia mengenai pengaruh dari book tax

differences dengan persistensi earning dan nilai perusahaan dilakukan

oleh  Martani (2010). Hasil penelitian ini membuktikan bahwa

perusahaan dengan BTD negatif yang besar, persistensi earning lebih

rendah dibanding dengan perusahaan kecil. Kaitannya book tax

differences dengan nilai perusahaan, penelitian ini menemukan bahwa

book tax differences berpengaruh positif terhadap performa perusahaan

di masa yang akan datang. Pemegang saham, sebagai pengawas

menyetujui tindakan tax avoidance yang dilakukan oleh manajemen

ketika keuntungan atau benefit yang akan diterima atas imbal jasa

aktivitas tersebut masih lebih tinggi dibanding dengan biaya yang

dikeluarkan. Selain itu, pajak juga menjadi salah satu faktor yang

memotivasi dan menentukan dalam pengambilan keputusan

perusahaan.



Di Indonesia, penegakan hukum dan kedisiplinan peraturan masih

rendah, sehingga tax avoidance lebih dipandang sebagai benefit bukan

risiko, karena risiko deteksi yang dapat diminimalkan.

Berdasarkan penjabaran tersebut hipotesis yang diajukan adalah

H3 : Tax avoidance berpengaruh positif terhadap nilai

perusahaan.

\



BAB III

METODOLOGI PENELITIAN

A. Tujuan Penelitian

Penelitian dilakukan untuk memenuhi tujuan sebagai berikut :

1. Mengetahui apakah metode persediaan rata-rata tertimbang dapat

mempengaruhi market value perusahaan.

2. Mengetahui apakah perputaran persediaan dapat mempengaruhi

market value perusahaan.

3. Mengetahui apakah tax avoidance dapat mempengaruhi market value

perusahaan.

4. Mengetahui apakah metode persediaan rata-rata tertimbang, perputaran

persediaan, dan tax avoidance dapat mempengaruhi market value

perusahaan.

B. Tempat dan Waktu Penelitian atau Objek Ruang Lingkup Penelitian

Objek dalam penelitian ini adalah laporan keuangan perusahaan

manufaktur sektor aneka industri yang terdapat BEI periode empat tahun

terakhir. Peneliti membatasi ruang lingkup penelitian ini pada pengaruh

metode persediaan rata-rata tertimbang, perputaran persediaan, dan tax

avoidance terhadap market value perusahaan.



C. Metode  Penelitian

Penelitian ini menggunakan pendekatan penelitian kuantitatif yaitu

jenis penelitian ilmiah yang sistematis terhadap bagian-bagian dan

fenomena serta pengaruh-pengaruhnya. Selain itu, penelitian kuantitatif

dipandang sebagai sesuatu yang bersifat konfirmasi dan deduktif.

Penelitian ini menggunakan angka mulai dari pengumpulan data, analisis

data, serta penampilan dari hasil analisis data yang diperoleh dengan

tujuan untuk menemukan ada tidaknya pengaruh antara variabel

independen dan dependen.

D. Populasi dan Sampling atau Jenis dan Sumber Data

Data yang digunakan dalam penelitian ini adalah data sekunder

berupa laporan keuangan tahunan perusahaan industri manufaktur sektor

aneka industri yang terdaftar di BEI dengan populasi tiga sembilan

perusahaan industri manufaktur dan diambil sampel sebanyak sepuluh

perusahaan manufaktur sektor anaeka industri, dengan akhir tahun

pembukuan pada tanggal 31 Desember 2010-2013. Sumber data dalam

penelitian ini diperoleh dari catatan laporan keuangan tahunan.

1. Sampel Perusahaan

Penelitian ini dilakukan pada Bursa Efek Indonesia (BEI). Objek

penelitian dalam penelitian ini adalah perusahaan manufaktur sektor aneka

industri yang terdaftar di BEI dari tahun 2010 sampai dengan tahun 2013.

Dengan menggunakan teknik penggambilan sampel berdasarkan purposive



sampling, maka dari tigapuluh sembilan populasi perusahaan yang layak

dijadikan sampel dalam penelitian ini adalah sebanyak 10 perusahaan

manufaktur sektor aneka industri, dengan  kriteria-kriteria sebagai berikut:

Tabel 3.1.1

Pemilihan Sampel

Dari 4 kriteria di atas yang dipilih dari daftar perusahaan

manufaktur sektor aneka indusri yang terdapat di BEI, maka akan diperinci

jenis  industrinya dari 10 perusahaan tersebut untuk lebih jelasnya terdapat

pada (lampiran 10, hal.31).



E. Teknik Pengumpulan Data atau Operasionalisasi Variabel Penelitian

Menurut Sugiono (2011:2), variabel penelitian adalah segala

sesuatu yang berbentuk apa saja yang ditetapkan oleh peneliti untuk

dipelajari sehingga diperoleh informasi tentang hal tersebut, kemudian

ditarik kesimpulannya. Terdapat tiga variabel bebas dan satu variabel

terikat yaitu Metode Persediaan Rata-Rata Tertimbang, Perputaran

Persediaan, Tax Avoidance dan Market Value Perusahaan.

1. Variabel Dependen

Menurut Sugiyono (2011:4) variabel dependen atau variabel terikat

merupakan variabel yang dipengaruhi atau yang akan menjadi akibat,

karena adanya variabel bebas. Variabel dependen (y)  yang digunakan

dalam penelitian ini adalah Market Value Perusahaan.

a. Definisi Konseptual

Nilai pasar (market value) adalah harga saham yang terjadi

di bursa saham pada saat tertentu yang ditentukan oleh pelaku pasar

(Jogiyanto,2008).

b. Deskripsi Operasional

Anoraga (2001:59) menyatakan bahwa nilai pasar

merupakan harga pasar riil dan harga yang paling mudah

ditentukan karena merupakan harga dari suatu saham perusahaan

pada pasar yang sedang berlangsung atau sudah tutup, berdasarkan

bursa utama. Nilai pasar menunjukan keadaan perusahaan

berdasarkan persepsi investor yang teraktualisasi dalam harga



saham. Secara garis besar nilai pasar perusahaan merupakan harga

seluruh saham yang beredar.

Anoraga (2001) memformulasikan bahwa :

2. Variabel Independen

Menurut Sugiyono (2011:4) variabel independen atau vang

menjadi sebab perubahannya atau timbulnya variabel dependen

(terikat). Adapun variabel independen yang digunakan dalam

penelitian ini adalah:

2.1 Metode Persediaan Rata-Rata Tertimbang

a. Definisi Konseptual

Metode rata-rata mengasumsikan persediaan yang tersedia untuk

dijual memiliki rata-rata biaya per unitnya sama (Weygandt, Kieso dan

Kimmel 2005:238).

b. Deskripsi Operasional

Perhitungan unit cost berdasarkan formula rata-rata tertimbang

adalah sebagai berikut: “Under ths method, the cost of goods available

for sale is allocated on the basis of the weight-average unit cost”,

Setelah dilakukannya perhitungan unit cost, selanjutnya menurut

weygandt, kieso, dan kimmel (2005:238) untuk mengetahui nilai biaya

dari persediaan akhir adalah sebagai berikut: “The weighted-average unit

cost is then applied to the units on hand. This computation determines the

cost of the ending inventory”. Dengan menggunakan metode rata-rata,



perusahaan akan dapat melakukan penghematan pajak (tax saving)

dikarenakan laba yang di dapat perusahaan dengan menggunakan metode

tersebut akan lebih kecil.

Dengan keterbatasan peneliti, dimana dalam laporan keuangan

tidak dicantumkan total unit persediaan, dan melainkan hanya

dicantumkan nilai persediaan akhir dan penggunakaan metode persediaan

rata-rata tertimbang, maka peneliti akan menggunakan nilai persediaan

akhir yang perhitunganya dengan metode rata-rata tertimbang sebagai

indikator dari metode rata-rata tertimbang. Hal ini didasarkan pada

pernyataan Sri Sulistyanto (2008:189) bahwa Nilai persediaan akhir

ditentukan atas dasar harga rata-rata tertimbang seluruh persedaan barang

serupa yang dimiliki perusahaan.

2.2 Perputaran Persediaan

a. Deskripsi Konseptual

Perputaran Persediaan (Inventory turnover) adalah rasio

efisiensi yang dihitung dengan membagi biaya barang yang terjual

(cost of good sold) dengan inventory (Ang, 1997).

b. Deskripsi Operasional

Perputaran Persediaan (Inventory turnover) mengukur

hubungan antara volume barang dagang yang dijual dengan jumlah

persediaan yang dimiliki selama periode berjalan (Thomson

2008:419).



Keterangan:

Persediaan rata-rata dapat dihitung dengan menggunakan angka-angka

mingguan, atau tahunan untuk menyederhanakan dalam menentukan

persediaan rata-rata dengan membagi jumlah persediaan pada akhir

dan awal tahun dengan membagi 2. Perputaran persediaan menjadi

ukuran yang menunjukkan berapa kali persediaan berputar dalam satu

periode. Harga pokok barang yang terjual dalam waktu satu tahun

dibagi dengan rata-rata nilai persediaan barang dagang. Selama jumlah

persediaan yang dimiliki sepanjang tahun stabil, rata-rata ini akan

cukup akurat dalam menganalisisnya.

2.3 Tax Avoidance

a. Deskripsi Konseptual

Tax Avoidance merupakan pengaturan untuk

meminimumkan atau menghilangkan beban pajak dengan

mempertimbangkan akibat pajak yang ditimbulkan (Mortenson

dalam Zain, 1988).

b. Deskripsi Operasional

Tax Avoidance, menurut Dyreng at al., 2010 dihitung

melalui CASH ETR (cash effective tax rate) perusahaan yaitu kas



yang dikeluarkan untuk biaya pajak dibagi dengan laba sebelum

pajak.

Keterangan:

Semakin besar CASH ETR ini mengindikasikan semakin rebdah tingkat

penghindaran pajak perusahaan.



Tabel 3.4.1

Operasionalisasi Variabel

Variabel Definisi Variabel Indikator Skala

Metode
persediaan
rata-rata
tertimbang
(Variabel
X1)

Sri Sulistyanto
(2008) bahwa Nilai
persediaan akhir
ditentukan atas dasar
harga rata-rata
tertimbang seluruh
persediaan barang
serupa yang dimiliki
perusahaan.

Nilai Persediaan Akhir dengan metode
persediaan rata-rata tertimbang

(Sri Sulistyanto 2008:189)

Rasio

Perputaran
Persediaan
(Varibel
X2)

Perputaran
Persediaan
(Inventory turnover)
mengukur pengaruh
antara volume
barang dagang yang
dijual dengan jumlah
persediaan yang
dimiliki selama
periode berjalan
(Thomson
2008:419).

(Thomson 2008:419)
Rasio

Tax
Avoidance
(Variabel
X3)

Tax Avoidance,
menurut Dyreng at
al., 2010 dihitung
melalui CASH ETR
(cash effective tax
rate) perusahaan
yaitu kas yang
dikeluarkan untuk
biaya pajak dibagi
dengan laba
sebelum pajak.

(Dyreng at al., 2010)
Rasio

Market
Value
Perusahaan
(Varibel Y)

Nilai perusahaan
adalah harga pasar
saham dikalikan
dengan jumlah
saham yang beredar
Anoraga (2001). (Anoraga,2001)

Rasio



F. Teknik Analisis Data

Langkah selanjutnya setelah melakukan pemilihan sampel,

menentukan variabel-variabel yang digunakan dalam penelitian, dan

membuat hipotesis uji, adalah melakukan pengelolahan data dengan

menggunakan analisis regresi berganda untuk menguji hipotesis yang telah

ditentukan. Analisa data dengan proses regresi tersebut akan dilakukan

dengan bantuan teknologi komputer yaitu program pengolah data statistik

software EViews versi 7.0.

1. Statistik Deskriptif

Menurut Sugiyono (2004:142), “Analisis deskriptif adalah statistik

yang digunakan untuk menganalisa data dengan cara mendeskripsikan

atau menggambarkan data yang telah terkumpul sebagaimana adanya

tanpa bermaksud membuat kesimpulan yang berlaku untuk umum atau

generalisasi.”

Suprayogi dalam STATISTIKA DESKRIPTIF, mengatakan

“Statstistika deskriptif (descriptive statistics) berkaitan dengan

penerapan metode statistik untuk mengumpulkan, mengolah,

menyajikan, dan menganalis data kuantitatif secara deskriptif”.

Dalam penelitian ini penulis akan memberikan gambaran atau

deskripsi data dari variabel dependen yaitu Market Value Perusahaan

serta variabel independen yaitu Metode Persediaan Rata-Rata

Tertimbang, Perputaran Persediaan dan Tax Avoidance. Analisis ini



disajikan dengan menggunakan tabel, grafik maupun diagram yang

selanjutnya akan diolah dengan metode lainya.

2. Analisa Regresi Data Panel

Dalam penelitian ini data yang digunakan adalah  data panel. Data

panel merupakan gabungan antara data time series dan data cross

section (Nachrowi, 2006:309). Data dikumpulkan dalam suatu rentang

waktu terhadap banyak individu. Data panel dalam penelititan ini

memiliki jumlah cross section sebanyak 10 perusahaan dengan

periode penelitan atau time series 4 tahun.

Menurut (Gujarati, 2012:238) terdapat 4 jenis data panel, yaitu:

1. Panel seimbang (balanced panel) adalah sebuah panel disebut

seimbang jika masing-masing subjek (perusahaan, individu, dan

lain-lain) memiliki jumlah observasi yang sama.

2. Panel tidak seimbang (unbalanced panel) adalah sebuah panel

disebut tidak seimbang jika masing-masing entitas memiliki

jumlah observasi yang berbeda.

3. Panel  pendek (short panel) adalah jika jumlah cross-section, N,

lebih besar dari pada perode waktu, T.

4. Panel panjang (long term) adalah jika T lebih besar dari N.



Sementara menurut Baltagi (dalam Gujarati, 2012:237) keuntungan

data panel adalah :

1. Oleh karena data yang berhubungan dengan individu, perusahaan,

Negara bagian, Negara, dan lain-lain, dari waktu-ke waktu, ada

batasan heterogenitas dalam unit-unit tersebut. Teknik estimasi

data panel dapat membatasi heterogenitas tersebut secara eksplisit

dengan memberikan variable spesifik-subjek.

2. Dengan menggabungkan antara observasi time-series dan cross-

section, data panel memberi “lebih banyak informasi, lebih

banyak variasi, sedikit kolinearitas antarvariabel, lebih banyak

degree of freedom, dan lebih efisien.

3. Dengan mempelajari observasi cross-section yang berulang-ulang,

data panel paling cocok untuk mempelajari dinamika perubahan.

4. Data panel paling baik untuk mendeteksi dan mengukur dampak

yang secara sederhana tidak bias dilihat pada data cross-section

murni atau time-series murni.

5. Data panel memudahkan untuk mempelajari model perilaku yang

rumit.

6. Dengan membuat data menjadi berjumlah beberapa ribu unit, data

panel dapat meminimumkan bias yang biasa terjadi jika kita

mengagregasi individu-individu atau perusahaan-perusahaan ke

dalam agregasi besar.



Meski memiliki keuntungan yang substantial, data panel memiliki

beberapa masalah seperti heteroskedastisitas, autokorelasi dan

korelasi silang seperti pada asumsi klasik, Namun ada beberapa

teknik estimasi yang bisa dipakai untuk menangani permasalahan-

permasalahan ini. Yang paling baik adalah (1) model fixed effect

(MET) dan (2) model random effect (MER), atau model komponen-

error (Gujarati, 2012:262)

Sejalan dengan itu (Nacchrowi:2006) juga menjelaskan untuk

mengestimasi parameter model dengan data panel, terdapat 3 teknik

dalam membuat regresi data panel, yaitu:

1. Pooling atau Ordinary Least Square (OLS)

Pada model ini digabungkan data cross section dan data

times series. Kemudian digunakan metode OLS terhadap data panel

tersebut. Pendekatan ini merupakan pendekatan yang paling

sederhana dibandingkan dengan kedua pendekatan lainnya. Dengan

pendekatan ini kita tidak bisa melihat perbedaan antar individu dan

perbedaan antar waktu karena intersep maupun slope dari model

sama.

Persamaan untuk OLS ditulis dengan persamaan sebagai

berikut:

Yit = α + βXit + εit; i=1,2,…., N; t=1,2,….., T



2. Model Efek Tetap (MET)

Adanya variabel-variabel yang tidak semuanya masuk

dalam model memungkinkan adanya intersep yang tidak konstan.

Atau dengan kata lain, intersep ini mungkin berubah untuk setiap

individu dan waktu.

Secara matematis model MET dinyatakan sebagai berikut:

Yit = α + βXit + γ2W2t + γ3W3t +…..+ γNWNt + δ2 Zi2 + δ3 Zi3 + δT

ZiT + εit

Dimana :

Yit = variabel terikat untuk individu ke-I dan waktu ke-t.

Xit = variabel bebas untuk individu ke-I dan waktu ke-t.

Wit = variabel boneka (dummy) dimana Wit =-1 untuk individu i,

i=1,2,.... N dan bernilai 0 untuk lainya.

Zit = variabel boneka (dummy) dimana Zit =-1 untuk periode t,

t=1,2,.... T dan bernilai 0 untuk lainya

Pada Fixed Effects Approach terdapat kemungkinan

persamaan regresi yang tergantung pada asumsi yang digunakan:

a. intersep dan slope dari koefisien tetap atau konstan sepanjang

waktu dan error term menangkap perbedaan-perbedaan

sepanjang waktu dan individu.

b. slope dari koefisien konstan tetapi intersep bervariasi

berdasarkan individu maupun pada waktu.



c. slope dari koefisien konstan tetapi intersep bervariasi

berdasarkan individu maupun pada waktu.

d. seluruh koefisien bervariasi pada individual.

e. intersep dan juga slope dari koefisien berbeda pada individu

maupun waktu.

Model fixed effect memiliki beberapa kelemahan yaitu:

a. terlalu banyak variabel boneka (dummy).

b. terlalu banyak variabel didalam model sehingga ada

kemungkinan terjadi multikoloniaritas.

c. tidak mampu mengidentifikasi dampak variabel-varibel time

inariant seperti jenis kelamin, warna dan etnik.

d. harus berhati-hati dalam memikirkan error term uit.

3. Model Efek Random (MER)

Dalam pendekatan ini perbedaan antar waktu dan antar

individu diakomodasi lewat error. Error dalam pendekatan itu

terbagi menjadi error untuk komponen individu dan error, error

komponen waktu, dan error gabungan. Penelitian ini menggunakan

metode Generalized Least Square (GLS). Keuntungan MER

dibandingkan MET adalah dalam hal derajat kebebasannya. Tidak

perlu dilakukan estimasi terhadap intersep N cross-sectional.



Berikut adalah persamaan untuk model MER:

Yit = α + βXit + εit; εit = ui + vt + wit

Dimana:

ui = komponen error cross section

vt = komponen error time-series

wit = komponen error gabungan.

2.1 Pengujian Model

Menurut Rosadi (2012:193), Uji Chow dan Uji Hausman

digunakan untuk memilih model yang terbaik dalam data panel

dari ketiga model yang tersedia (OLS, MET, dan MER) seperti

yang sudah disebutkan di atas.

2.1.1 Uji Chow (F Statistik)

Uji Chow (F Statistik) adalah pengujian yang dilakukan

untuk mengetahui apakah model yang digunakan adalah pooled

least square atau fixed effect.

Rumus yang digunakan dalam test ini adalah:

CHOW=

Dimana:

RRSS= restricted residual sum square.

URSS= unreatricted residual sumsSquare.

N= jumlah data cross section.

(RRSS-URSS)/N-1

URSS/(NT-N-K)



T= jumlah data time series.

K= jumlah variabel penjelasan.

Sementara itu hipotesa yang digunakan dalam pengujian ini

adalah:

Ho : Model menggunakan pendekatan Pool Least Square (OLS).

H1 : Model menggunakan pendekatan Fixed Effect (MET).

Pengujian ini mengikuti distribusi F statistik, dimana jika F

statistik lebih besar dari F tabel maka Ho ditolak. Nilai Chow

menunjukkan nilai F statistik dimana bila nilai Chow yang kita

dapat lebih besar dari nilai F tabel yang digunakan berarti kita

menggunakan model fixed effect. Atau juga menggunakan p-value

jika p-value > 0.05 maka Ho diterima jika p-value < 0.05 maka

Ho ditolak.

2.1.2 Uji Hausman

Uji Hausman digunakan untuk menentukan apakah

menggunakan model fixed effect atau model random effect

(Gujarati, 2012:252)

Model Uji Haussman yang digunakan adalah sebagai

berikut:



Sementara itu hipotesa yang digunakan dalam pengujian ini

adalah:

Ho= Model menggunakan random efek

H1= Model menggunakan fixed efek

Dengan ketentuan jika p-value > 0.05 maka Ho diterima jika

p-value < 0.05 maka Ho ditolak.

2.1.3 Pengujian Statistik Model

Pengujian dilakukan melalui uji signifikansi variabel bebas

(uji t) dan uji signifikansi model (uji F stat).

2.1.3.1 Uji Signifikansi Variabel bebas (Uji t)

Menurut Suharyadi dan Purwanto (2004:523) “Uji secara

parsial (uji statistik t) adalah untuk menguji apakah suatu variabel

bebas berpengaruh atau tidak terhadap variabel tidak bebas.

Ho: βi=0

H1: βi≠0

Nilai beda menunjukkan slope variabel bebas. Bila nilai

statistik beta sama dengan nol maka variabel bebas tidak memiliki

hubungan signifikan dengan variabel terikat.

Kriteria penerimaan Ho adalah sebagai berikut:

a. Berdasarkan perbandingan t-statistik dengan t-tabel.

Kita membandingkan nilai t hitung dengan t tabel, dengan

derajat bebas n-2, dimana n adalah banyaknya jumlah



pengamatan serta tingkat signifikansi yang dipakai. (bila t

statistik > t tabel maka Ho diterima dan bila t statistik < t

tabel maka Ho diterima).

b. Berdasarkan probabilitas dengan membandingkan nilai

p-value dengan p=0.05 dengan kententuan jika p-value >

0.05, maka Ho diterima dan jika p-value < 0.05 maka Ho

ditolak.

2.1.3.2 Uji Signifikansi Model (Uji F Stat)

Uji F berguna untuk menguji apakah koefisien regresi

signifikan (berbeda nyata). Koefisien regresi yang signifikan

adalah koefisien regresi yang secara statistik tidak sama dengan

nol.

Menurut Suharyadi dan Purwanto (2004:523) “Uji secara

simultan (uji global) digunakan untuk melihat kemampuan

menyeluruh dari variabel bebas terhadap variabel tidak bebas

secara bersama-sama.

Uji F yang dipakai dalam penelitian ini adalah:

Ho: β1, β2, β3=0

Ho: β1, β2, β3≠0

Beta merupakan slope variabel bebas model.



Kriteria penerimaan Ho adalah sebagai berikut:

a. Berdasarkan perbandingan F-statistik dengan F tabel:

Bila F statistik > Fα;(k,n-k-1) maka Ho ditolak.

Bila F statistik < Fα;(k,n-k-1) maka Ho diterima.

b. Berdasarkan probabilitas :

Jika p-value > 0.05, maka Ho diterima.

Jika p-value < 0.05, maka Ho ditolak .

2.1.3.3 Uji R Square dan Adjusted R Square

R square dan Adjusted R square disebut juga koefisien

determinasi, Koefisien ini menjelaskan berapa besar proporsi

variasi dalam dependen yang dapat dijelaskan oleh variabel-

variabel independen secara bersama-sama. Nilai ini menunjukkan

seberapa dekat garis regresi yang kita estimasi dengan data yang

sesungguhnya. Nilai R² (mendekati 100%) semakin baik model

regresi tersebut. Nilai sebesar 0 berarti variasi pada variabel

dependen tidak dapat diterangkan sama sekali oleh variabel

independennya, dan sebaliknya.

3. Langkah Teknis Aplikasi Eviews 7

Penelitian ini menggunakan aplikasi komputer bernama Eviews

versi 7 karena aplikasi ini yang mampu untuk mengolah data berupa

data panel dibanding aplikasi pengolah data lainya, secara umum



aplikasi ini mempunyai fitur yang hampir sama dengan pengolah data

lain seperti IBM SPSS, AMOS, dll hanya berbeda pada langkah-

langkah pengoperasianya. Dan berikut adalah langkah-langkah

pengolahan data menggunakan Eviews 7:

a. Tabulasi data yang diperoleh melalui Laporan keuangan dari 10

perusahaan selama 4 tahun terakhir melalui program Ms. Excel

2010.

b. Memasukan (import) data dari hasil tabulasi ke dalam program

eviews untuk dilakukan pengolahan data, dengan cara:

1. Klik File -> Open -> Foreign Data as Workfile.

2. Pilih file data excel hasil tabulasi yang telah disusun, next.

3. Melakukan setting sebagai berikut:

c. Memisahkan data panel berdasarkan perusahaan dengan cara:

1. Pada menu Proc pilih Reshape Current Page -> Unstack in

New Page.

2. Isi series name pada text box pertama dengan “perusahaan”.

3. Isi text box kedua dengan “tahun perusahaan”.



4. Sisipkan “_” (underscore) diantara * dan ? pada text box

ketiga.

d. Memulai object data panel (Pooled) untuk membuat model regresi

yang diperlukan:

1. Pilih menu Object -> New Object -> Pool.

2. Identifikasi data cross section dengan mengetikkan label nama

masing-masing data cross section sesuai penamaan yang

diberikan, dalam penelitian ini menggunakan kode sebagai

berikut:

_ARGO, _ASII, _GJTL, _HDTX, _KBLI, _LPIN, _MYTX,

_PRAS, _SCCO, _VOKS

e. Mengestimasi Model Regresi OLS dengan cara:

1. Pilih menu estimate lalu memasukan spesifikasi dependent

variabel market value perusahaan dan common coefficient

konstanta di ikuti ketiga variabel bebas dengan memilih



“none” pada method dan mencentang balanced sampel,

sebagai berikut:

f. Mengestimasi Model Regresi MET dan mengujinya dengan model

OLS:

1. Estimasi model MET menggunakan spesifikasi yang sama

dengan model OLS namun menggunakan efek fixed pada cross

section:

2. Setelah mendapatkan hasil estimasi model, melakukan uji

chow dengan cara memilih menu View -> Fixed/Random

Effect Testing -> Redudant Fixed Effect – Likelihood Ratio.

3. Melakukan pengujian hipotesis sesuai pada kententuan uji

Chow seperti yang telah dijelaskan diatas.



g. Mengestimasi Model Regresi MER dan mengujinya dengan model

MET:

1. Estimasi model MER dengan spesifikasi merubah cross

section efek menjadi random sebagai berikut:

2. Menguji model MET dan MER melalui uji hausman

dengan cara memilih menu View -> Fixed/Random Effect

Testing -> Correlated Random Effect – Hausman Test.

3. Pengujian hipotesis sesuai ketentuan yang telah dijelaskan

pada sub bab sebelumnya.

h. Setelah melakukan pengujian model, langkah selanjutnya

mengetahui hasil dari representasi dari model tersebut:

1. Pilih menu view -> Estimation Output untuk mengetahui

model yang terbaik.

2. Pilih menu view -> Representations untuk mengetahui

persamaan regresi tiap individu.



BAB IV

HASIL DAN PEMBAHASAN

A. Deskripsi Data

1. Statistik Deskriptif

Statistik deskriptif memberikan gambaran umum mengenai data

penelitian. Secara keseluruhan statistik deskriptif dari setiap variabel

dapat dilihat pada tabel dibawah ini:

1.1 Deskripsi Market Value Perusahaan pada Perusahaan

Manufaktur Sektor Aneka Industri yang terdaftar di Bursa

Efek Indonesia

Menurut Hartono dalam Anggono dan Baridwan (2003), nilai pasar

adalah harga saham yang terjadi di bursa pada saat tertentu, yang

ditentukan oleh permintaan dan penawaran saham yang bersangkutan

di pasar saham. Berdasarkan definisi tersebut, maka secara

operasional penelitian ini merupakan harga saham pada saat

penutupan pada perdagangan akhir saat publikasi laporan keuangan

tahunan (Linda Kusumaning Wedari, 2006). Dalam penelitian ini, data

pertumbuhan Market Value Perusahaan didapat dari laporan yang

telah di olah lebih lanjut oleh indonesian capital market dictionary

(ICMD). Data yang digunakan adalah data perusahaan Manufaktur

Sektor Aneka Industri yang terdaftar di Bursa Efek Indonesia selama



periode penelitian yaitu tahun 2010-2013.

Berikut adalah data market value perusahaan manufaktur sektor

aneka industri yang terdaftar di Bursa Efek Indonesia selama periode

penelitian, maka dapat dihitung nilai statistik deskriptifnya. Hasil

perhitungan dengan menggunakan program Eviews 7 adalah sebagai

berikut :

Tabel 4.1.1.1

Hasil Analisis Deskriptif Market Value Perusahaan

MVP?

Mean 4530000000000,00
Median 626000000000,00

Maximum 31900000000000,00
Minimum 46800000000,00

Std. Dev. 8340000000000,00
Skewness 2,28

Kurtosis 7,15

Observations 40,00
Cross sections 10,00
Sumber: data diolah peneliti tahun 2014 dengan Eviews 7

Keluaran tampilan Eviews menunjukkan market value perusahaan

terkecil (Minimum) dari keseluruhan perusahaan manufaktur diatas

adalah Rp. 46.800.000.000 (pembulatan program Eviews),- yaitu

PT. Multi Prima Sejahtera Tbk (LPIN) yang terjadi pada tahun 2011,

ini disebabkan karena perusahaan ini termasuk dalam industri yang

kecil jika dibandingkan dengan perusahaan yang lain pada sektor yang

sama, sehingga investor lebih condong ke perusahaan yang sudah



berskala besar harga saham pada saat itu pun hanya dikisaran

Rp. 2.000. Sedangkan market value tertinggi (Maximum) untuk tahun

adalah sebesar Rp. 31.900.000.000.000 (pembulatan program

Eviews),- yaitu  PT. Astra International Tbk (ASII) yang terjadi pada

tahun 2011, pada saat itu ASII mengalami kenaikan volume penjualan

yang cukup signifikan sehingga menarik investor untuk membeli

saham ASII sehingga saham mengalami kenaikan ke level Rp. 7.400.

Rata-rata market value perusahaan dari 10 perusahaan adalah

sebesar Rp 4.530.000.000.000 pada periode 2010-2013. Hasil statistik

juga menunjukan variabel market value perusahaan memiliki standar

deviasinya sebesar Rp 8.340.000.000.000 (seberapa jauh rentang data

dari mean), nilai skewnees  sebesar 2.28 menunjukan variabel market

value tidak simetris dan lebih condong ke kanan (Positively Sweked)

sedangkan nilai kurtosis sebesar 7.15 > 3 yang berarti memiliki kurva

sangat runcing (leptokurtic). Dalam penelitian ini menggunakan 10

perusahaan (Cross sections) dengan 4 tahun sumber laporan

keuangan, jadi total terdapat 40 Observations.

1.2 Deskripsi Metode Persediaan Rata-Rata Tertimbang pada

Perusahaan Manufaktur yang terdaftar di Bursa Efek Indonesia

Persediaan merupakan salah satu aktiva yang penting dalam

kegiatan operasi perusahaan dagang. Persediaan juga merupakan

aktiva lancar terbesar dari perusahaan manufaktur maupun dagang.



Pengaruh persediaan terhadap laba lebih mudah terlihat ketika

kegiatan bisnis sedang berfluktuasi. Persediaan merupakan salah satu

investasi modal yang dimiliki perusahaan. Pada umumnya setiap

perusahaan menggunakan sebagian besar uangnya untuk membeli

persediaan, oleh karena itu persediaan memegang peranan penting

dalam kelangsungan proses produksi. Mengingat hal tersebut, maka

sudah seharusnya jika suatu perusahaan melakukan pengendalian

terhadap persediaan, sehingga persediaan dapat digunakan sesuai

dengan kebutuhan secara efisien.

Dalam penelitian ini, metode persediaan rata-rata tertimbang

di proxykan pada nilai persediaan yang di ambil adalah Nilai Nominal

dari persediaan akhir yang tersedia dalam laporan keuangan tahunan

perusahaan manufaktur sektor aneka industri yang terdaftar di Bursa

Efek Indonesia selama periode penelitian yaitu tahun 2010-2013.



Hasil perhitungan dengan menggunakan program Eviews 7 adalah

sebagai berikut :

Tabel 4.1.2.1

Hasil Analisis Deskriptif Metode Persediaan Rata-Rata

Tertimbang

MRT?
Mean 1.630.000.000.000
Median 221.000.000.000
Maximum 153.00000.000.000
Minimum 24.900.000.000
Std. Dev. 3.950.000.000.000
Skewness 2,72
Kurtosis 8,71
Observations 40

Cross
sections

10

Sumber: data diolah peneliti tahun 2014 dengan eviews 7

Keluaran tampilan Eviews menunjukkan metode persediaan rata-

rata tertimbang terkecil (Minimum) sebesar Rp 24.900.000.000

(pembulatan program Eviews)  yaitu PT. Multi Prima Sejahtera Tbk

(LPIN) pada tahun 2011, hal ini disebabkan karena pada tahun

tersebut LPIN tidak terlalu banyak menginvestasikan modal usahanya

untuk persediaan dan dapat disebabkan karena beberapa hal misalnya

untuk mengurangi biaya penyimpanan dan perawatan persediaan,

selain itu juga mengurangi penimbunan persediaan karena persediaan

yang terlalu lama disimpan dapat mengurangi kualitas persediaan



tersebut. Sedangkan tertinggi (Maximum) untuk tahun 2012 adalah Rp

153.00000.000.000 (pembulatan program Eviews) yaitu   PT. Astra

International Tbk (ASII), ini menandakan bahwa perusahaan

memutuskan untuk menginvestasikan modal usaha yang cukup tinggi

untuk persediaan, hal ini bisa disebabkan karena perusahaan ingin

meningkatkan volume penjualan dengan meningkatkannya volume

penjualan dengan meningkatkanya volume penjualan kemungkinan

besar laba perusahaan pun akan ikut meningkat, dengan meningkatnya

laba perusahaan akan memberikan sinyal positif bagi para investor

untuk melakukan investasi pada perusahaan tersebut karena para

investor cenderung meningkatkan perusahaan yang memiliki laba

tinggi dan stabil. Rata-rata metode persediaan rata-rata tertimbang dari

10 perusahaan adalalah sebesar Rp 1.630.000.000.000 pada periode

2010-2013.

Hasil statistik juga menunjukan variabel metode persediaan rata-

rata tertimbang memiliki standar deviasinya sebesar Rp

3.950.000.000.000 (seberapa jauh rentang data dari mean), nilai

skewness sebesar 2.72 menunjukan variabel metode persediaan rata-

rata tertimbang tidak simetris dan lebih condong ke kanan (Positively

Sweked) sedangkan nilai kurtosis sebesar 8.71 > 3 yang berarti

memiliki kurva sangat runcing (leptokurtic). Dalam penelitian ini

menggunakan 10 perusahaan (Cross sections) dengan 4 tahun sumber

laporan keuangan, jadi total terdapat 40 Observations.



1.3    Deskripsi Perputaran Persediaan pada Perusahaan Manufaktur

Sektor Aneka Industri yang terdaftar di Bursa Efek Indonesia

Perputaran persediaan menunjukkan berapa kali jumlah persediaan

barang dagangan diganti dalam satu tahun. Tingkat perputaran

persediaan mengukur perusahaan dalam memutar barang

dagangannya, dan menunjukkan pengaruh antara barang yang

diperlukan untuk mengimbangi tingkat penjualan yang ditentukan.

Sebagai contoh, toko penjual makanan akan mempunyai tingkat

turnover yang jauh lebih tinggi daripada pabrik pembuat pesawat

terbang. Persediaan barang jadi yang cukup akan memberikan

fleksibelitas bagi perusahaan untuk skedul produksi dan

pemasarannya. Dengan persediaan yang cukup perusahaan dapat

memnuhi peranan dengan cepat.

Namun demikian persediaan yang besar itu juga membawa

konsekuensi berupa biaya yang timbul adalah keusangan atau

persediaan. Faktor-faktor yang mempengaruhi perputaran, yaitu

tingkat penjualan, sifat teknis dan lainnya proses produksi, dan daya

tahan produk akhir (faktor mode).



Hasil perhitungan dengan menggunakan program Eviews versi 7

adalah sebagai berikut :

Tabel 4.1.3.1

Hasil Analisis Deskriptif Perputaran Persediaan

PP?
Mean 13.06269
Median 12.14663
Maximum 30.67382
Minimum 2.16001
Std. Dev. 7.663729
Skewness 0.557253
Kurtosis 2.614764
Observations 40
Cross sections 10

Sumber: data diolah peneliti tahun 2014 dengan eviews 7

Keluaran tampilan Eviews menunjukkan perputaran persediaan

terkecil (Minimum) untuk tahun 2013 adalah 2,16 kali  yaitu

PT. Multi Prima Sejahtera Tbk (LPIN), menandakan dengan

meningkatnya laba perusahaan akan memberikan sinyal positif bagi

para investor untuk melakukan investasi pada perusahaan tersebut,

karena para investor untuk melakukan investasi pada perusahaan

tersebut, karena para investor cenderung meningkatkan perusahaan

yang memiliki laba tinggi dan stabil . Sedangkan tertinggi (Maximum)

untuk tahun 2011 sebanyak 30,67 kali yaitu PT. Supreme Cable

Manufacturing & Commerece Tbk. (SCCO), ini menandakan bahwa

perusahaan memutuskan untuk persediaan, hal ini bisa disebabkan

karena perusahaan ingin meningkatkan jumlah produksinya agar dapat

meningkatkan volume penjualan dengan meningkatnya volume



penjualan kemungkinan besar laba perusahaan pun akan mengikuti.

Rata-rata perputaran persediaan  dari 10 perusahaan adalah

sebanyak 13.06 kali pada periode 2010-2013. Hasil statistik juga

menunjukan variabel perputaran persediaan memiliki standar

deviasinya sebesar 7.66 kali (seberapa jauh rentang data dari mean),

nilai skewness sebesar 0.557 menunjukan variabel perputaran

persediaan simetris dan cenderung normal ditengah, sedangkan nilai

kurtosis 2.61 < 3 yang berarti memiliki kurva yang tumpul

(platikurtik). Dalam penelitian ini menggunakan 10 perusahaan (Cross

sections) dengan 4 tahun sumber laporan keuangan, jadi total terdapat

40 Observations.

1.4   Deskripsi Tax Avoidance pada Perusahaan Manufaktur Sektor

Aneka Industri yang terdaftar di Bursa Efek Indonesia

Tax Avoidance (penghindaran pajak) berkenaan dengan pengaturan

sesuatu peristiwa sedemikian rupa untuk meminimkan atau

menghilangkan beban pajak dengan memperhatikan ada atau tidaknya

akibat-akibat pajak yang ditimbulkannya. Oleh karena itu,

penghindaran pajak tidak merupakan pelanggaran atas perundang-

undangan perpajakan atau secara etika tidak dianggap salah dalam

rangka usaha wajib pajak untuk mengurangi, menghindari,

meminimkan atau meringkankan beban pajak dengan cara-cara yang



dimungkinkan oleh undang-undang pajak. Sebagai contoh  adalah

diberikannya keringanan bagi investor yang ingin menanamkan modal

di wilayah Indonesia Timur, karena mencari lokasi yang tarif

pajaknya rendah. Dalam penelitian ini, tax avoidance yang di ambil

dari pembayaran pajak dibagi laba sebelum pajak yang tersedia dalam

laporan keuangan tahunan perusahaan Manufaktur Sektor Aneka

Industri yang terdaftar di Bursa Efek Indonesia selama periode

penelitian yaitu tahun 2010-2013.

Hasil perhitungan dengan menggunakan program Eviews versi 7

adalah sebagai berikut:

Tabel 4.1.4.1

Hasil Analisis Deskriptif Tax Avoidance

TA?
Mean 0.933977
Median 0.790657
Maximum 3.14786
Minimum 0.210398
Std. Dev. 0.539226
Skewness 2.275161
Kurtosis 9.171603
Observations 40
Cross sections 10

Sumber: data diolah peneliti tahun 2014

Keluaran tampilan Eviews menunjukkan tax avoidance terkecil

(Minimum) untuk tahun 2011 adalah 0,21 % yaitu PT. Prima Alloy

Steel Universal Tbk (PRAS), hal ini menunjukan bahwa perusahaan

tidak terlalu banyak melakukan penghindaran pajak karena penerapan



hal misalnya tidak ingin mengambil resiko yang akan terjadi

dikemudian hari.. Sedangkan tertinggi (Maximum) untuk tahun 2013

adalah 3,15% yaitu PT Argo Pantes Tbk (ARGO), menandakan bahwa

perusahaan melakukan penghindaran pajak yang lebih tinggi

dibanding perusahaan, hal ini disebabkan karena perusahaan ingin

meningkatkan laba perusahaan dengan cara meminimalkan pajaknya

dengan cara meningatkanya laba perusahaan akan memberikan

keuntungan bagi para investor untuk melakuan investasi pada

perusahaan tersebut karena para investor cenderung meningkatkan

perusahaan yang memiliki laba tinggi dan stabil.

Rata-rata tax avoidance dari 10 perusahaan adalah sebesar Rp

4.530.000.000.000 pada periode 2010-2013. Hasil statistik juga

menunjukan variabel market value perusahaan memiliki standar

deviasinya sebesar Rp 8.340.000.000.000 (seberapa jauh rentang data

dari mean), nilai skewnees  sebesar 2.28 menunjukan variabel market

value tidak simetris dan lebih condong ke kanan (Positively Sweked)

sedangkan nilai kurtosis sebesar 7.15 > 3 yang berarti memiliki kurva

sangat runcing (leptokurtic). Dalam penelitian ini menggunakan 10

perusahaan (Cross sections) dengan 4 tahun sumber laporan

keuangan, jadi total terdapat 40 Observations.



B. Pengujian Hipotesis

Sebelum dilakukan pengujian hipotesis, ada beberapa pengujian

yang harus dipenuhi agar kesimpulan-kesimpulan dari pengujian hipotesis

tersebut tidak bias, diantaranya adalah uji Chow dan uji Hausman.

Pengujian ini dilakukan karena data dalam penelitian ini menggunakan

data panel yang mengandung unsur time series 4 tahun pengamatan dan

cross section pada 10 perusahaan, sehingga perlu dilakukan pemilihan

model regresi yang tepat. Untuk langkah-langkah yang lebih jelas dilihat

pada (lampiran 8, hal. 11)

1. Pemilihan Model Regresi Data Panel

Estimasi model-model yang akan diuji  menggunakan Eviews 7

dengan memasukkan data-data dari variabel. Variabel-variabel

tersebut kemudian disingkat untuk memudahkan dalam memasukkan

ke program sebagai berikut:

MVP = Market value perusahaan sebagai variabel dependen (Y).

MRT = Metode persediaan rata-rata tertimbang sebagai variabel

independen ke1 (X1).

PP     = Perputaran persediaan sebagai variabel indpenden ke2 (X2).

TA    = Tax avoidance sebagai variabel independen ke3 (X3).

Selanjutnya adalah mengestimasi model regresi yang pertama yaitu

model OLS, hasil dari OLS menunjukan keluaran sebagai berikut:



1.1 Pengujian 1 dengan OLS

Tabel 4.2.1.1

Hasil Regresi dengan Model Ordinary Least Square (OLS)

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 1, hal.1)

Dari keluaran diatas menghasilan persamaan regresi sebagai

berikut:

MVP = -339000000000 + 1.858MRT + 192000000000 PP -

710000000000 TA

Model OLS ini tidaklah menjadi model terbaik karena perlu

dibandingkan dengan model yang lain, sesuai langkah pemilihan

model maka selanjutnya adalah mencari model regresi dengan efek

tetap (MET) melalui program eviews 7.



1.2 Pengujian 2 dengan MET

Tabel 4.2.1.2

Hasil Regresi dengan Model Efek Tetap (MET)

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 2, hal.2)

Dari model MET dapat rumuskan persamaan regresi berganda

sebagai berikut:

MVP = 27100000000 + 1.318MRT + 157000000000PP +

332000000000TA

1.3 Membandingkan model OLS dengan MET

Tabel 4.2.1.3

Perbandingan model OLS dengan MET

Sumber: data diolah peneliti tahun 2014 dengan eviews 7



Tabel diatas menunjukan bahwa kedua model mempunyai

perbedaan yang mencolok pada constanta, dimana model OLS

memiliki constanta negatif sedangkan MET positif begitu pula pada

koefisien variabel TA. F-stats dari kedua model sama-sama signifikan

dengan  sebesar 0.0000, namun R-Square MET lebih tinggi.

Untuk itu langkah selanjutnya adalah menguji kedua model

tersebut dengan uji Chow-test pada menu eviews fixed/random effect

testing dengan lalu Redundant Fixed Effects Tests dengan hipotesis:

Ho: Model mengikuti OLS..

H1: Model mengikuti MET

1.4 Pengujian model OLS dengan MET (Uji Chow-test), memilih model yang

terbaik

Tabel 4.2.1.4

Hasil Uji Chow-test

Redundant Fixed Effects Tests
Pool: PUTRI
Test cross-section fixed effects

Effects Test Statistic d.f. Prob.

Cross-section F 5.191309 (9,27) 0.0004
Cross-section Chi-square 40.178459 9 0.0000

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 3, hal.3)

Dari keluaran tersebut menunjukan baik F test maupun chi-square

signifikan (p-value sebesar 0.0004 lebih kecil dari 0.05) , sehingga Ho

ditolak dan Model MET lebih baik daripada model OLS. Model MET



tersebut akan dibandingkan dengan model ke-3 yaitu model MER.

Oleh karena itu perlu dilakukan estimasi model MER terlebih dahulu

dengan eviews 7 yang menghasilkan keluaran sebagai berikut:

1.5 Pengujian 3 dengan MER

Tabel 4.2.1.5

Hasil Regresi dengan Model Efek Random (MER)

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 4, hal.4)

Rumus  persamaan regresi berganda yang dapat diambil dari model

ini adalah sebagai berkut:

MVP= -880000000000 + 1.841572 MRT + 182000000000 PP +

92200000000 TA



1.6 Membandingkan model MET dan MER

Tabel 4.2.1.6

Perbandingan model MET dan MER

Sumber: data diolah peneliti tahun 2014 dengan eviews 7

Terlihat dari tabel 4.2.1.6, diatas bahwa model MER mempunyai

koefisien negatif dan mempunyai F-stats yang signifikan sebesar

0.000. Namun R-Square lebih kecil dibanding model MET.

Dan untuk membuktikan model terbaik dari kedua model tersebut

yaitu MET dan MER akan diuji dengan uji Hausman, model terbaik

inilah yang akan digunakan dalam penelitian ini. Uji Hausman

memiliki hipotesis:

Ho: Model mengikuti MER.

H1: Model mengikuti MET.



1.7 Pengujian model MET dengan MER (Uji Hausman), memilih model

yang terbaik

Tabel 4.2.1.7

Hasil Uji Hausman

Test Summary Chi-Sq. Statistic Chi-Sq. d.f. Prob.

Cross-section random 2.784892 3 0.4260

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 5, hal.6)

Berdasarkan keluaran uji hausman terlihat bahwa p-value= 0.426 >

0.05  sehingga Ho diterima. Dengan demikian dapat disimpulkan

bahwa model MER lebih baik dibandingkan MET. Model dengan

MER inilah yang akan dianalisa dalam penelitian ini, model MER

dapat dirumuskan kedalam persamaan regresi berganda dibawah ini:

MVP= -880000000000 + 1.841572 MRT + 182000000000 PP +

92200000000 TA.

Konstanta sebesar -880000000000  artinya  apabila  tidak  terdapat

variabel independen  seperti  metode persediaan rata-rata tertimbang,

perputaran persediaan, dan tax avoidance (variabel bernilai 0) maka

besarnya market value perusahaan adalah sebesar -880000000000.

Dalam kenyataan market value negatif adalah hal yang tidak mungkin

namun tujuan model regresi adalah untuk memahami hubungan antara

prediktor dan pengaruhnya.



Koefisien regresi  metode persediaan rata-rata tertimbang pada

pengujian tersebut  sebesar  1.841572  artinya  metode persediaan

rata-rata tertimbang  memiliki pengaruh  positif  terhadap market

value perusahaan dimana bila metode persediaan rata-rata tertimbang

naik sebesar  1 satuan  maka market value perusahaan  akan  naik

sebesar  1.841572  dengan  asumsi  besarnya  variabel-variabel  yang

lain  tidak  berubah.

Koefisien regresi perputaran persediaan pada pengujian tersebut

sebesar 182000000000 artinya perputaran persediaan memiliki

pengaruh positif terhadap market value perusahaan dimana bila

perputaran persediaan naik sebesar 1 satuan maka market value

perusahaan akan naik sebesar 182000000000 dengan asumsi  besarnya

variabel-variabel  yang  lain  tidak  berubah.

Koefisien tax avoidance pada  pengujian  tersebut  sebesar

92200000000 artinya tax avoidance memiliki pengaruh positif

terhadap market value perusahaan dimana bila tax avoidance naik

sebesar 1% maka market value perusahaan akan naik sebesar

92200000000  dengan  asumsi  besarnya  variabel-variabel  yang  lain

tidak  berubah.

Selain itu, dari model MER tersebut juga dapat diambil interpretasi

lain secara individual dimana setiap perusahaan akan memiliki

pengaruh individu terhadap MVP sehingga bisa didapatkan persamaan

regresi berganda tiap perusahaan yang dapat digunakan untuk analisa



masing-masing perusahaan, pengaruh individu tersebut dapat dilihat

dari hasil representasi dari keluaran eviews 7 yaitu nilai C cross

section yang selanjutnya dijumlahkan dengan nilai C pada model

umum yaitu -880000000000 untuk mendapatkan nilai total C yang

digunakan untuk persamaan regresi masing-masing perusahaan.

1.8 Representasi Model Regresi tiap Perusahaan

Tabel 4.2.1.8

Hasil Representasi Model Regresi tiap Perusahaan

dengan nilai C secara individual

Perusahaan Nilai C individual Total Nilai C
_GJTL--C 3100000000000 2220000000000

_SCCO--C 2390000000000 1510000000000

_ASII--C 399000000000 -481000000000

_LPIN--C 314000000000 -566000000000

_PRAS--C -74000000000 -954000000000

_HDTX--C -512000000000 -1392000000000

_ARGO--C -794000000000 -1674000000000

_VOKS--C -927000000000 -1807000000000

_KBLI--C -1380000000000 -2260000000000

_MYTX--C -2510000000000 -3390000000000

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 6, hal.9)

Dari tabel tersebut dapat disimpulkan beberapa hal, antara lain:

a. PT. Gajah Tunggal Tbk atau GJTL mempunyai pengaruh individu

(nilai c) terbesar dengan yang lain, sehingga jika dimasukan

kedalam persamaan maka akan mendapatkan nilai total c sebesar

220000000000 dengan persamaan regresi individu sebagai

berikut:



MVP= 220000000000 + 1.841572 MRT + 182000000000 PP +

92200000000 TA

Artinya jika terjadi perubahan MRT, PP dan TA baik antar

perusahaam maupun antar waktu, maka perusahaan GJTL akan

mendapatkan pengaruh individu terhadap perubahan MVP

sebesar total 220000000000.

b. Sedangkan perusahaan yang pengaruh individu terendah dengan

asumsi yang sama adalah MYTX atau PT. Apac Citra Centertex

Tbk dengan nilai -3390000000000 walaupun dalam kenyataan

tidak terjadi negatif.

2. Pengujian Hipotesis secara Parsial (Uji t)

Pengujian ini digunakan untuk menguji apakah suatu variabel

bebas berpengaruh atau tidak terhadap variabel tidak bebas. Pengujian

ini berdasarkan keluaran dari model MER. Dan berikut adalah

hipotesis-hipotesis statistik yang akan di uji :

Ho= tidak ada pengaruh variable bebas secara parsial terhadap Market

Value Perusahaan.

H1= Penerapan metode persediaan rata-rata tertimbang

berpengaruh terhadap market value perusahaan.

H2= Perputaran persediaan berpengaruh terhadap market value

perusahaan.

H3= Tax Avoidance berpengaruh terhadap market value perusahaan.



Tabel 4.2.2.1

Nilai p-value tiap variabel

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 4, hal.4)

Berdasarkan hasil keluaran Eviews model MER diatas terdapat

p-value tiap variabel dan didapatkan hasil sebagai berikut:

a. p-value MRT sebesar 0.0000 kurang dari 0.05 maka Ho ditolak.

Adanya pengaruh antara MRT terhadap MVP.

b. p-value PP sebesar 0.0157 kurang dari 0.05 maka Ho ditolak.

Adanya pengaruh antara PP terhadap MVP.

c. p-value TA sebesar 0.8849 lebih dari 0.05 maka Ho diterima.

Tidak Adanya pengaruh antara TA terhadap MVP.

3. Pengujian Hipotesis secara Simultan (Uji F)

Pengujian ini digunakan untuk mengetahui ada tidaknya pengaruh

ketiga variabel independen secara simultan terhadap variabel

dependen. Pengujian F dalam penelitian ini berdasarkan dari model

MER adalah sebagai berikut:

Ho: β1, β2, β3=0 (tidak ada pengaruh MRT, PP dan TA terhadap

MVP secara simultan).



Ho: β1, β2, β3≠0 (ada pengaruh MRT, PP dan TA terhadap MVP

secara simultan).

Tabel 4.2.3.1

F-Statistic model MER

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 4, hal. 4)

Hasil keluaran Eviews diatas menunjukkan nilai Prob(F-statistic)

sebesar 0.000000. Berarti p-value sebesar 0.000000 kurang dari 0.05

maka Ho ditolak.

4. Uji R Square dan Adjusted R Squared

R square dan Adjusted R square disebut juga koefisien determinasi,

Koefisien ini menjelaskan berapa besar proporsi variasi dalam

dependen yang dapat dijelaskan oleh variabel-variabel independen

secara bersama-sama. Jika Nilai R² R Squared (mendekati 100%)

semakin baik model regresi tersebut. Nilai   sebesar 0 berarti variasi

pada variabel dependen tidak dapat diterangkan sama sekali oleh

variabel independennya, dan sebaliknya.  Nilai R Squared pada model

MER adalah :



Tabel 4.2.4.1

Hasil R Squared model MER

Sumber: data diolah peneliti tahun 2014 dengan eviews 7 (lampiran 4, hal.4)

Dari hasil pengolahan Regresi Berganda diketahui bahwa koefisien

determinasi R-Squared = 0.794053. Artinya seluruh variabel

independen (Metode Persediaan Rata-Rata Tertimbang, Perputaran

Persediaan,  dan Tax Avoidance)  hanya mampu  menjelaskan variasi

dari  variabel dependen  (Market  Value Perusahaan)  adalah  sebesar

79.4053%.  Sedangkan  sisanya mampu dijelaskan oleh faktor-faktor

lain yang tidak diikutsertakan dalam model.

C. Pembahasan

Pembahasan yang dilakukan peneliti merupakan interpretasi dari

pengujian yang dilakukan terhadap hipotesis awal dari penelitian ini yang

sudah diuji baik melalui uji t maupun uji F pada model MER yang akan di

dibandingkan dengan penelitian terdahulu maupun teori yang relevan,

sehingga bisa didapatkan kesimpulan secara empiris berdasarkan

pengujian yang telah dilakukan.



1. Analisis Pengaruh Metode Persediaan Rata-rata Tertimbang

terhadap Market Value Perusahaan

Berdasarkan hasil uji t diatas terlihat bahwa p-value MRT sebesar

0.0000 kurang dari 0.05 maka Ho ditolak. Yang berarti ada pengaruh

penerapan metode persediaan rata-rata tertimbang terhadap market

value perusahaan secara signifikan (dengan peluang kesalahan 5%).

Hasil ini melemahkan penelitian yang terdahulu oleh Bambang

Sudaryono dan Hilda (2005) dan penelitian dari Abubakar Arif dan

Resti Jayeng  Ramadhanti (2009) yang menyimpulkan bahwa variabel

arus biaya persediaan menunjukkan tidak terdapat pengaruh yang

signifikan antara metode arus biaya persediaan terhadap market value

perusahaan.

Perbedaan ini disebabkan penelitian yang dilakukan dimana

peneliti hanya mengamati metode persediaan rata-rata tertimbang saja

di 10 perusahaan manufaktur sektor aneka industri yang diproxykan

pada nilai persediaan dan menggunakan teknik analisis data yang

berbeda yaitu model data panel. Sedangkan penelitian terdahulu

mengamati metode persediaan FIFO dan Rata-Rata Tertimbang

dengan menggunakan dummy di perusahaan manufaktur yang lebih

luas lingkupnya dan untuk teknik analisis datanya menggunakan

SPSS.



Hasil penelitian ini diperkuat dengan teori (Anthony et al, 2000)

yang menjelaskan ada pengaruh yang signifikan antara metode

persediaan rata-rata tertimbang terhadap market value perusahaan.

Laba yang cenderung kecil dan stabil ini berdampak pada perusahaan

yang melakukan penghematan pajak (tax saving). Kondisi ini akan

direspon oleh investor atau para pemegang saham yang lebih memilih

perusahan yang memiliki laba yang stabil, sehingga mereka

berinvestasi pada perusahaan tersebut yang pada akhirnya akan

menaikan harga saham perusahaan. Kenaikan harga perusahaan

mencerminkan kenaikan market value perusahan.

Hal tersebut dapat diverifikasi melalui data pertumbuhan MVP dan

MRT pada perusahaan KBLI dan ASII yang terdapat pada (lampiran 9

a dan b, hal. 24). Dari grafik yang terdapat pada (lampiran 9, hal. 24)

pertumbuhan MVP dan MRT pada kedua perusahaan tersebut diatas

selama 4 tahun dari 2010-2013, terlihat bahwa perubahan MRT

berpengaruh berpengaruh positif terhadap perubahan MVP, dimana

adanya kenaikan MRT berakibat pada kenaikan MVP dari perusahan

tersebut.

Temuan ini melemahkan penelitian sebelumnya dari Abubakar

Arif dan Resti Jayeng  Ramadhanti (2009) yang menyimpulkan bahwa

perputaran persediaan menunjukkan tidak terdapat pengaruh yang

signifikan antara perputaran persediaan terhadap market value

perusahaan.



Perbedaan ini disebabkan penelitian yang dilakukan dimana

peneliti hanya mengamati perputaran persediaan di 10 perusahaan

manufaktur sektor aneka industri dan menggunakan teknik analisis

data yang berbeda yaitu model data panel. Sedangkan penelitian

terdahulu mengamati perputaran persediaan di lingkup perusahaan

manufaktur yang lebih luas dan menggunakan teknik analisis data

yaitu SPSS.

Penelitian ini diperkuat menurut Jumingan (2006:128) adanya

pengaruh yang signifikan antara perputaran persediaan terhadap

market value perusahaan. Hal ini membuktikan bahwa perusahaan

tersebut khususnya manufaktur sektor aneka industri yang diteliti

mampu menaikan volume penjualan jika perputaran persediaan yang

tinggi atau sebaliknya. Volume penjualan yang tinggi akan menarik

investor untuk melakukan investasi terhadap perusahaan tersebut,

sehingga menaikan market value perusahaan atau sebaliknya jika

volume penjualan turun akan memicu investor untuk berpikir ulang

untuk membeli saham perusahaan tersebut yang berdampak pada

perubahan market value perusahaan. Dan perbandingan data

pertumbuhan MVP dan PP dari 2 perusahaan LPIN dan ARGO, dapat

dilihat pada (lampiran 9 c dan d, hal. 25 dan 26).

Dari kedua grafik yang terdapat pada pada (lampiran 9 c dan d,

hal 25 dan 26) terlihat bahwa PP berpengaruh positif terhadap

perusahaan, pada perusahaan LPIN PP mempunyai kecenderungan



naik lalu menurun di akhir tahun, begitu juga MVP-nya yang

mempunyai kecenderungan yang sama dimana sempat naik di tahun

2012 lalu turun lagi di akhir tahun 2013. Sedangkan pada perusahaan

ARGO terlihat penurunan PP juga diikuti penurunan MVP selama 3

tahun, walaupun di tahun ke-4 (2013) mengalami kenaikan, tapi bukan

berarti PP tidak berpengaruh melainkan ada faktor lain yang

bersamaan. Namun secara keseluruhan dari 4 tahun periode 3 tahun

mengikuti kecenderungan grafik PP.

2. Analisis Pengaruh Perputaran Persediaan terhadap Market Value

Perusahaan

Hasil uji t selanjutnya menghasilkan p-value pada Perputaran

Persediaan sebesar 0.0157 kurang dari 0.05 sehingga menolak Ho.

Sehingga dapat disimpulkan Hipotesis ke-2 dalam penelitian ini

terbukti bahwa ada pengaruh perputaran persedian terhadap market

value perusahaan.

Temuan ini melemahkan penelitian sebelumnya dari Abubakar

Arif dan Resti Jayeng Ramadhanti (2009) yang menyimpulkan bahwa

perputaran persediaan menunjukkan tidak terdapat pengaruh yang

signifikan antara perputaran persediaan terhadap market value

perusahaan.

Penelitian ini diperkuat menurut Jumingan (2006:128) adanya

pengaruh yang signifikan antara perputaran persediaan terhadap



market value perusahaan. Menurut Jumingan (2008:128) menjelaskan

bahwa : “Perputaran Persediaan menunjukkan barang dijual dan

diadakan kembali selama satu periode akuntansi” dan menyebutkan

ada beberapa faktor yang mempengaruhi perputaran persediaaan, yaitu

: tingkat penjualan, sifat teknis dan lamanya proses produksi, dan daya

tahan produk akhir (faktor mode).

Hal ini membuktikan bahwa perusahaan tersebut khususnya

manufaktur sektor aneka industri yang diteliti mengindikasikan ada

kenaikkan volume penjualan jika perputaran persediaan yang tinggi

atau sebaliknya. Volume penjualan yang tinggi akan menarik investor

untuk melakukan investasi terhadap perusahaan tersebut karena laba

akan cenderung naik dengan rendahnya biaya operasional, sehingga

menaikkan market value perusahaan atau sebaliknya jika volume

penjualan turun akan memicu investor untuk berpikir ulang untuk

membeli saham perusahaan tersebut karena laba cenderung turun,

selain itu Jumlah persediaan yang terlalu besar dibanding dengan

kebutuhan, akan menyebabkan beban yang harus ditanggung

perusahaan menjadi besar  seperti beban bunga, biaya penyimpanan,

pemeliharaan gudang,  resiko kerusakan, menurunya kualitas barang

dalam penyimpanan, biaya keamanan dan sebagainya semua itu

adalah faktor yang menyebabkan keuntungan perusahaan berkurang,

sebaliknya persediaan yang terlalu kecil adapat menghambat

operasional perusahaan berupa tidak tersedianya barang pada saat



dibutuhkan sehingga menyebabkan perusahaan kehilangan

kesempatan untuk meraih laba. Karena tidak tersediaanya persediaan

perusahaan tidak dapat bekerja secara optimal berarti “Capital Asset”

dan “Direct Labor” tidak dapat didayagunakan sepenuhnya  sehingga

biaya operasional atau produksi rara-rata akan menjadi tinggi yang

berakibat keuntungan yang dapat diperoleh menjadi menurun. yang

berdampak pada perubahan market value perusahaan.

Tinggi rendahnya perputaran persediaan mempunyai efek langsung

terhadap besar kecilnya modal yang diinvestasikan dalam persediaan.

Makin tinggi perputaran persediaannya, berarti makin cepat

perputarannya, yang berarti makin pendek waktu terikatnya modal

dalam persediaan, sehingga untuk memnenuhi volume sales atau cost

of goods sold tertentu dengan naiknya perputaran dibutuhkan jumlah

modal yang lebih kecil.

Menurut Wiagustini (2010, dalam Nina Sufiana dan Ni Ketut

Purnawati), bahwa pengelolaan persediaan merupakan suatu pekerjaan

yang sulit, kesalahan dalam menentukan tingkat persediaan dapat

berakibat fatal.  Besarnya persediaan dapat ditingkatkan sepanjang ada

penghematan. Keseimbangan antara penghematan dan biaya yang

timbul sangat tergantung atas tambahan biaya simpan dan

pengendalian persediaan yang efisien.

Sedangkan menurut Syahyunan (2003:10) besarnya tingkat

perputaran persediaan tergantung pada sifat barang, letak perusahaan



dan jenis perusahaan. Tingkat perputaran persediaan yang rendah

dapat disebabkan over investment dalam persediaan. Sebaliknya

tingkat perputaran persedian yang tinggi menunjukan dana yang

diinvestasikan pada persediaan efektif menghasilkan laba. Dari teori

diatas dapat dilihat bahwa perputaran persediaan memiliki pengaruh

terhadap keuntungan (laba) yang berdampak pula pada keputusan

investor untuk membeli saham perusahaan sehingga berpengaruh pada

market value perusahaan.

Perbandingan data pertumbuhan MVP dan PP dari 2 perusahaan

LPIN dan ARGO, dapat dilihat pada (lampiran 9 c dan d, hal. 25 dan

26). Dari kedua grafik yang terdapat pada pada (lampiran 9 c dan d,

hal 25 dan 26) terlihat bahwa PP berpengaruh positif terhadap

perusahaan, pada perusahaan LPIN PP mempunyai kecenderungan

naik lalu menurun di akhir tahun, begitu juga MVP-nya yang

mempunyai kecenderungan yang sama dimana sempat naik di tahun

2012 lalu turun lagi di akhir tahun 2013. Sedangkan pada perusahaan

ARGO terlihat penurunan PP juga diikuti penurunan MVP selama 3

tahun, walaupun di tahun ke-4 (2013) mengalami kenaikan, tapi bukan

berarti PP tidak berpengaruh melainkan ada faktor lain yang

bersamaan. Namun secara keseluruhan dari 4 tahun periode 3 tahun

mengikuti kecenderungan grafik PP.



3. Analisis Pengaruh Tax Avoidance terhadap Market Value

Perusahaan

Hasil dari penelitian sebelumnya menyebutkan bahwa

tax avoidance mempengaruhi nilai perusahaan, terutama untuk

perusahaan yang transparansinya baik oleh Desai dan Dharmapala

(2009). Berbeda dengan hasil penelitian dalam Hipotesis ke-3 dimana

p-value Tax Avoidance sebesar 0.8849 lebih dari 0.05 yang menerima

Ho. Berarti bahwa tidak ada pengaruh Tax Avoidance terhadap market

value perusahaan.

Perbedaan ini disebabkan penelitian yang dilakukan dimana

peneliti hanya mengamati pada 10 perusahaan manufaktur sektor

aneka industri saja dan menggunakan teknik analisis data yang

berbeda yaitu model data panel. Sedangkan penelitian terdahulu

mengamati perusahaan manufaktur yang lingkupnya lebih luas dan

menggunakan teknik analisis data yaitu SPSS.

Penelitian ini diperkuat dalam teori tradisional tax avoidance yang

masih dianggap sebagai aktivitas untuk mentransfer kesejahteraan dari

Negara kepada pemegang saham (Kim et. Al.; 2011). Tax Avoidance

menurut peraturan pajak tidak dilarang meskipun seringkali mendapat

sorotan yang kurang baik karena dianggap memiliki konotasi negatif

ataupun dianggap kurang nasionalis (Wirawan dan Diaz, 2013:16).



Namun disisi lain pengetahuan investor di Indonesia yang masih

kurang paham tentang perpajakan menjadikan aktivitas tax avoidance

dipandang negatif dan memilih mengambil aman karena menurut

(Friese: 2006) ada beberapa resiko yang ditimbulkan oleh kegiatan tax

avoidance antara lain: denda, publisitas dan reputasi. Jadi sebenarnya

kegiatan yang dianggap negative itu adalah tax evasion yang secara

sengaja mengelakkan pajak, dan dapat dicontohkan, seperti tidak

menyetorkan dan melaporkan pajak penghasilan yang telah dipotong,

baik dari karyawan maupun dari pemberi jasa ke kas negara;

menggelembungkan biaya perusahaan untuk mengecilkan laba bersih

fiskal sehingga pembayaran pajak yang kecil (Thomas Sumarsan,

2013:117). Saat ini investor belum menjadikan tax avoidance

seutuhnya sebagai faktor dalam penentuan investasinya, sehingga

tidak berdampak pada perubahan market value perusahaan walaupun

sebenarnya memberikan kesejahteraan bagi pemegang saham dan

lebih dipengaruhi faktor lain.

Dalam 2 perusahaan yang diteliti yaitu SCCO dan VOKS dapat

dibandingkan perubahan TA dan MVP yang terdapat pada (lampiran 9

e dan f, hal. 27 dan 28). Dari pengamatan pada 2 perusahaan tersebut

terlihat TA belum mampu mempengaruhi market value perusahaan

secara signifikan, dimana pada perusahaan SCCO grafik TA pada

tahun ke 1 dan 2 mengalami kenaikan bersamaan naiknya market

value perusahaan, namun pada tahun 3 dan 4 penurunanya tidak di



ikuti penurunan market value persahaan. Hal tersebut juga terjadi pada

perusahaan VOKS di tahun ke 1 dan 2 kenaikan tax avoidance diikuti

dengan drastisnya kenaikan market value perusahaan, namun pada

tahun ke 3 kenaikan TA tidak diikuti market value perusahaan yang

terus menurun, walaupun tahun ke-4 TA juga menurun.

4. Analisis Pengaruh Metode Persediaan Rata-rata Tertimbang,

Perputaran Persediaan dan Tax Avoidance terhadap Market Value

Perusahaan secara bersama-sama

Adapun hasil uji signifikansi model dari uji F yang digunakan

untuk menguji apakah ada pengaruh variabel independen secara

bersama-sama terhadap variabel dependen, hasil menunjukan bahwa

p-value sebesar 0.000000 kurang dari 0.05. Berarti Hipotesis ke-4

terbukti dengan adanya pengaruh  dari metode persediaan rata-rata

tertimbang, perputaran persediaan dan tax avoidance terhadap market

value perusahaan  secara bersama-sama dan signifikan.

Sedangkan kemampuan regresi linear berganda model MER dalam

menjelaskan tingkat penjelasan model terhadap variabel dependen,

mengacu pada besarnya koefisien determinasi (R-Square) sebesar

0.794053 atau 79,4053%. Hal ini menunjukan bahwa model sangat

baik untuk menjelaskan pengaruh secara simultan.

Jika dilihat pada analisis parsial dimana setiap variabel dependen

diatas yaitu metode persediaan rata-rata tertimbang, perputaran



persediaan dan tax avoidance secara teori atau menurut penelitian

terdahulu mempunyai tujuan yang hampir sama yaitu meningkatkan

dan menjaga perolehan laba yang stabil bagi perusahaan ternyata

secara simultan ketiga variabel tersebut berpengaruh positif terhadap

market value perusahaan dengan tingkat signifikan yang tinggi.

Dan pada model regresi ketiga variabel tersebut mempunyai

pengaruh positif  terhadap perusahaan, dimana jika ada kenaikan pada

ketiga variabel dependen tersebut maka akan diikuti pula kenaikan

pada market value perusahaan. Gambaran melalui grafik historis

pengaruhnya variabel  MRT, PP dan TA terhadap MVP pada

perusahaan ASII dan KBLI, dapat dilihat pada (lampiran 9 g dan h,

hal. 29 dan 30).

Dari data penilitian perusahaan ASII dan KBLI menunjukan

adanya persamaan trend yang ditunjukan oleh 3 variabel bebas yang

cenderung naik selama 4 tahun, begitu pula diikuti kenaikan market

value dari kedua perusahaan tersebut.



BAB V

KESIMPULAN, IMPLIKASI DAN SARAN

A. Kesimpulan

Berdasarkan hasil pengujian hipotesis dan mengacu pada

perumusan serta tujuan penelitian, kesimpulan yang dapat ditarik adalah

sebagai berikut:

1. Metode Persediaan Rata-Rata Tertimbang (X1) berpengaruh terhadap

Market Value Perusahaan (Y), artinya metode persediaan rata-rata

terimbang akan menghasilkan laba akuntansi yang cenderung lebih

kecil dan stabil ini berdampak pada perusahaan yang melakukan

penghematan pajak. Karena kondisi ini direspon oleh investor atau

para pemegang saham yang lebih memilih perusahaan tersebut yang

pada akhirnya akan menaikkan harga saham perusahaan. Kenaikkan

harga perusahaan mencerminkan kenaikkan market value perusahaan.

2. Perputaran Persediaan (X2) berpengaruh terhadap Market Value

Perusahaan (Y), artinya jika semakin cepat perputaran persediaan ini

menunjukkan perusahaan mengalami penjualan yang tinggi sekaligus

dapat mengurangi beban biaya penyimpanan persediaan. Karena

volume penjualan yang tinggi akan menarik investor untuk melakukan

investasi terhadap perusahaan tersebut, sehingga menaikkan market

value perusahaan atau sebaliknya jika volume penjualan turun akan



memicu investor untuk berpikir ulang untuk membeli saham

perusahaan tersebut yang berdampak pada perubahan market value

perusahaan.

3. Tidak adanya pengaruh tindakan tax avoidance (X3) terhadap market

value perusahaan (Y), artinya perubahan tax avoidance baik naik atau

turunnya belum mampu mempengaruhi market value perusahaan.

Walaupun tax avoidance dianggap sebagai aktivitas untuk mentransfer

kesejahteraan dari negara kepada pemegang saham, namun disisi lain

pengetahuan investor di Indonesia yang masih kurang paham tentang

perpajakan menjadikan aktivitas tax avoidance dipandang negatif.

Karena ada beberapa resiko yang ditimbulkan oleh kegiatan tax

avoidance antara lain: denda, publisitas, dan reputasi, sehingga

investor belum menjadikan tax avoidance sebagai faktor dalam

penentuan investasinya walaupun sebenarnya memberikan

kesejahteraan bagi pemegang saham dan lebih dipengaruhi faktor lain.

4. Secara bersamaan Metode Persediaan Rata-Rata Tertimbang (X1),

Perputaran Persediaan (X2), dan Tax Avoidance (X3) berpengaruh

terhadap Market Value Perusahaan (Y) secara signifikan. Karena

ketiga variabel tersebut mempunyai tujuan yang hampir sama yaitu

untuk menaikkan atau menstabilkan laba perusahaan, sehingga

menarik investor untuk membeli saham tersebut dan market value

perusahaan pun naik.



B. Implikasi

Metode Persediaan Rata-Rata Tertimbang berimplikasi pada

perusahaan harus konsisten dalam menerapkan metode arus biaya rata-rata

tertimbang dengan tidak mengganti dengan metode lainya dan kewajiban

perusahaan melaporkan metode arus biaya yang digunakan kedalam

laporan keuangan sehingga bisa memberikan informasi yang jelas.

Perputaran Persediaan berimplikasi pada semakin cepat perputaran

persediaan menunjukkan penjualan yang tinggi sekaligus dapat

mengurangi beban biaya penyimpanan persediaan. Volume penjualan yang

tinggi akan menarik investor untuk melakukan investasi terhadap

perusahaan tersebut sehingga menaikkan market value perusahaan. Hal ini

berimplikasi pada perusahaan yang harus menjaga kestabilan penjualanya

dan selalu berusaha untuk meningkatkan volume penjualan dan juga

mengatur persediaan agar bisa memenuhi permintaan konsumen.

Tidak adanya pengaruh tax avoidance pada market value

perusahaan karena pengetahuan investor di Indonesia yang masih kurang

paham tentang perpajakan menjadikannya dipandang negatif, sehingga

investor belum menjadikan tax avoidance sebagai faktor penentu investasi.

Berimplikasi pada perusahaan untuk selalu memberikan citra positif

kepada investor dengan tidak melakukan tindakan tax evasion seiring

dengan berkembangya seminar pajak tentang cara meminimalkan pajak

sehingga kedepanya investor akan mengerti tentang tax avoidance

perusahaan yang legal dan tidak lagi memandang negatif.



C. Saran

Untuk pengembangan lebih lanjut, maka peneliti memiliki

beberapa saran, yaitu :

1. Bagi Akademisi

a. Untuk penelitian selanjutnya, sampel perusahaan manufaktur

yang digunakan sebaiknya diperluas sektornya dan pemilihan

jangka waktu yang digunakan dalam penelitian lebih dari empat

tahun.

b. Penelitian selanjutnya sebaiknya mempertimbangkan kondisi tax

avoidance di Indonesia kaitannya dengan pengetahuan investor

Indonesia mengenai tax avoidance.

2. Bagi Praktisi

a. Bagi Manajer Perusahaan Manufaktur, agar perusahaan tetap

secara konsisten menerapkan metode persediaan rata-rata

tertimbang tanpa merubah ke metode yang lain agar kestabilan

laba tetap terjaga.

b. Bagi Investor, agar dalam melakukan investasi harus tepat

memilah perusahaan mana yang mempunyai kestabilan laba.

Serta mempelajari tentang perpajakan agar bisa mengetahui

perusahaan yang melakukan tax avoidance dan tax evasion yang

melanggar peraturan.
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LAMPIRAN

1) Hasil OLS

Dependent Variable: MVP?
Method: Pooled Least Squares
Date: 05/11/14   Time: 16:51
Sample: 1 4
Included observations: 4
Cross-sections included: 10
Total pool (balanced) observations: 40

Variable Coefficient Std. Error t-Statistic Prob.

C -3.39E+11 1.03E+12 -0.330304 0.7431
MRT? 1.858142 0.105998 17.53003 0.0000

PP? 1.92E+11 5.44E+10 3.527527 0.0012
TA? -7.10E+11 7.30E+11 -0.972047 0.3375

R-squared 0.920409 Mean dependent var 4.53E+12
Adjusted R-squared 0.913776 S.D. dependent var 8.34E+12
S.E. of regression 2.45E+12 Akaike info criterion 59.98553
Sum squared resid 2.16E+26 Schwarz criterion 60.15442
Log likelihood -1195.711 Hannan-Quinn criter. 60.04659
F-statistic 138.7704 Durbin-Watson stat 1.169557
Prob(F-statistic) 0.000000



2) Hasil FEM (MET)

Dependent Variable: MVP?
Method: Pooled Least Squares
Date: 05/10/14   Time: 15:19
Sample: 1 4
Included observations: 4
Cross-sections included: 10
Total pool (balanced) observations: 40

Variable Coefficient Std. Error t-Statistic Prob.

C 2.71E+10 1.68E+12 0.016151 0.9872
MRT? 1.318260 0.469974 2.804960 0.0092

PP? 1.57E+11 9.87E+10 1.587713 0.1240
TA? 3.32E+11 6.66E+11 0.497589 0.6228

Fixed Effects
(Cross)

_ARGO--C -1.93E+12
_ASII--C 6.40E+12
_GJTL--C 3.64E+12
_HDTX--C -1.42E+12
_KBLI--C -2.24E+12
_LPIN--C -6.03E+11

_MYTX--C -3.55E+12
_PRAS--C -1.03E+12
_SCCO--C 2.47E+12
_VOKS--C -1.74E+12

Effects Specification

Cross-section fixed (dummy variables)

R-squared 0.970850 Mean dependent var 4.53E+12
Adjusted R-squared 0.957895 S.D. dependent var 8.34E+12
S.E. of regression 1.71E+12 Akaike info criterion 59.43107
Sum squared resid 7.90E+25 Schwarz criterion 59.97995
Log likelihood -1175.621 Hannan-Quinn criter. 59.62953
F-statistic 74.93795 Durbin-Watson stat 2.774581
Prob(F-statistic) 0.000000



3) Hasil Uji Chow

Redundant Fixed Effects Tests
Pool: PUTRI
Test cross-section fixed effects

Effects Test Statistic d.f. Prob.

Cross-section F 5.191309 (9,27) 0.0004
Cross-section Chi-square 40.178459 9 0.0000

Cross-section fixed effects test equation:
Dependent Variable: MVP?
Method: Panel Least Squares
Date: 05/10/14   Time: 15:21
Sample: 1 4
Included observations: 4
Cross-sections included: 10
Total pool (balanced) observations: 40

Variable Coefficient Std. Error t-Statistic Prob.

C -3.39E+11 1.03E+12 -0.330304 0.7431
MRT? 1.858142 0.105998 17.53003 0.0000

PP? 1.92E+11 5.44E+10 3.527527 0.0012
TA? -7.10E+11 7.30E+11 -0.972047 0.3375

R-squared 0.920409 Mean dependent var 4.53E+12
Adjusted R-squared 0.913776 S.D. dependent var 8.34E+12
S.E. of regression 2.45E+12 Akaike info criterion 59.98553
Sum squared resid 2.16E+26 Schwarz criterion 60.15442
Log likelihood -1195.711 Hannan-Quinn criter. 60.04659
F-statistic 138.7704 Durbin-Watson stat 1.169557
Prob(F-statistic) 0.000000



4) Hasil MER

Dependent Variable: MVP?
Method: Pooled EGLS (Cross-section random effects)
Date: 05/10/14   Time: 15:22
Sample: 1 4
Included observations: 4
Cross-sections included: 10
Total pool (balanced) observations: 40
Swamy and Arora estimator of component variances

Variable Coefficient Std. Error t-Statistic Prob.

C -8.80E+11 1.29E+12 -0.679638 0.5011
MRT? 1.814572 0.172533 10.51722 0.0000

PP? 1.82E+11 7.16E+10 2.535080 0.0157
TA? 9.22E+10 6.33E+11 0.145733 0.8849

Random Effects
(Cross)

_ARGO--C -7.94E+11
_ASII--C 3.99E+11
_GJTL--C 3.10E+12
_HDTX--C -5.12E+11
_KBLI--C -1.38E+12
_LPIN--C 3.14E+11

_MYTX--C -2.51E+12
_PRAS--C -7.40E+10
_SCCO--C 2.39E+12
_VOKS--C -9.27E+11

Effects Specification
S.D. Rho

Cross-section random 2.01E+12 0.5798
Idiosyncratic random 1.71E+12 0.4202

Weighted Statistics

R-squared 0.794053 Mean dependent var 1.77E+12
Adjusted R-squared 0.776890 S.D. dependent var 3.61E+12
S.E. of regression 1.71E+12 Sum squared resid 1.05E+26
F-statistic 46.26733 Durbin-Watson stat 2.228176
Prob(F-statistic) 0.000000



Unweighted Statistics

R-squared 0.916890 Mean dependent var 4.53E+12
Sum squared resid 2.25E+26 Durbin-Watson stat 1.035769



5) Hasil Hausman

Correlated Random Effects - Hausman Test
Pool: PUTRI
Test cross-section random effects

Test Summary
Chi-Sq.
Statistic Chi-Sq. d.f. Prob.

Cross-section random 2.784892 3 0.4260

Cross-section random effects test comparisons:

Variable Fixed Random Var(Diff.) Prob.

MRT? 1.318260 1.814572 0.191108 0.2562

PP?
156766918
975.09025

181548810
581.86984

462044904
049765810

0000 0.7154

TA?
331616120
375.35931

921950346
75.200800

439282284
854206940

00000 0.2533

Cross-section random effects test equation:
Dependent Variable: MVP?
Method: Panel Least Squares
Date: 05/10/14   Time: 15:22
Sample: 1 4
Included observations: 4
Cross-sections included: 10
Total pool (balanced) observations: 40

Variable Coefficient Std. Error t-Statistic Prob.

C 2.71E+10 1.68E+12 0.016151 0.9872
MRT? 1.318260 0.469974 2.804960 0.0092

PP? 1.57E+11 9.87E+10 1.587713 0.1240
TA? 3.32E+11 6.66E+11 0.497589 0.6228



Effects Specification

Cross-section fixed (dummy variables)

R-squared 0.970850 Mean dependent var 4.53E+12
Adjusted R-squared 0.957895 S.D. dependent var 8.34E+12
S.E. of regression 1.71E+12 Akaike info criterion 59.43107
Sum squared resid 7.90E+25 Schwarz criterion 59.97995
Log likelihood -1175.621 Hannan-Quinn criter. 59.62953
F-statistic 74.93795 Durbin-Watson stat 2.774581
Prob(F-statistic) 0.000000



6) Representasi MER

Estimation Command:
=====================
LS(CX=R) MVP? MRT? PP? TA?

Estimation Equations:
=====================
MVP_ARGO = C(5) + C(1) + C(2)*MRT_ARGO + C(3)*PP_ARGO + C(4)*TA_ARGO

MVP_ASII = C(6) + C(1) + C(2)*MRT_ASII + C(3)*PP_ASII + C(4)*TA_ASII

MVP_GJTL = C(7) + C(1) + C(2)*MRT_GJTL + C(3)*PP_GJTL + C(4)*TA_GJTL

MVP_HDTX = C(8) + C(1) + C(2)*MRT_HDTX + C(3)*PP_HDTX + C(4)*TA_HDTX

MVP_KBLI = C(9) + C(1) + C(2)*MRT_KBLI + C(3)*PP_KBLI + C(4)*TA_KBLI

MVP_LPIN = C(10) + C(1) + C(2)*MRT_LPIN + C(3)*PP_LPIN + C(4)*TA_LPIN

MVP_MYTX = C(11) + C(1) + C(2)*MRT_MYTX + C(3)*PP_MYTX + C(4)*TA_MYTX

MVP_PRAS = C(12) + C(1) + C(2)*MRT_PRAS + C(3)*PP_PRAS + C(4)*TA_PRAS

MVP_SCCO = C(13) + C(1) + C(2)*MRT_SCCO + C(3)*PP_SCCO + C(4)*TA_SCCO

MVP_VOKS = C(14) + C(1) + C(2)*MRT_VOKS + C(3)*PP_VOKS + C(4)*TA_VOKS

Substituted Coefficients:
=====================
MVP_ARGO = -794287648646 - 880022982637 + 1.8145717821*MRT_ARGO +
181548810582*PP_ARGO + 92195034675.2*TA_ARGO

MVP_ASII = 398713351485 - 880022982637 + 1.8145717821*MRT_ASII +
181548810582*PP_ASII + 92195034675.2*TA_ASII

MVP_GJTL = 3.09625299856e+12 - 880022982637 + 1.8145717821*MRT_GJTL +
181548810582*PP_GJTL + 92195034675.2*TA_GJTL

MVP_HDTX = -512276674637 - 880022982637 + 1.8145717821*MRT_HDTX +
181548810582*PP_HDTX + 92195034675.2*TA_HDTX

MVP_KBLI = -1.37712766984e+12 - 880022982637 + 1.8145717821*MRT_KBLI +
181548810582*PP_KBLI + 92195034675.2*TA_KBLI

MVP_LPIN = 313596176087 - 880022982637 + 1.8145717821*MRT_LPIN +
181548810582*PP_LPIN + 92195034675.2*TA_LPIN

MVP_MYTX = -2.51318889725e+12 - 880022982637 + 1.8145717821*MRT_MYTX +
181548810582*PP_MYTX + 92195034675.2*TA_MYTX



MVP_PRAS = -73969936730.9 - 880022982637 + 1.8145717821*MRT_PRAS +
181548810582*PP_PRAS + 92195034675.2*TA_PRAS

MVP_SCCO = 2.38970736337e+12 - 880022982637 + 1.8145717821*MRT_SCCO +
181548810582*PP_SCCO + 92195034675.2*TA_SCCO

MVP_VOKS = -927419062387 - 880022982637 + 1.8145717821*MRT_VOKS +
181548810582*PP_VOKS + 92195034675.2*TA_VOKS

Perusahaan C Ci C+Ci

_GJTL--C
-

8.80E+11
3.10E+12 2.22E+12

_SCCO--C
-

8.80E+11
2.39E+12 1.51E+12

_ASII--C
-

8.80E+11
3.99E+11

-
4.81E+11

_LPIN--C
-

8.80E+11
3.14E+11

-
5.66E+11

_PRAS--C
-

8.80E+11
-

7.40E+10
-

9.54E+11
_HDTX--

C
-

8.80E+11
-

5.12E+11
-

1.39E+12
_ARGO--

C
-

8.80E+11
-

7.94E+11
-

1.67E+12

_VOKS--C
-

8.80E+11
-

9.27E+11
-

1.81E+12

_KBLI--C
-

8.80E+11
-

1.38E+12
-

2.26E+12
_MYTX--

C
-

8.80E+11
-

2.51E+12
-

3.39E+12



7) Deskripsi (statistik deskriptif)

MVP? MRT? PP? TA?
Mean 4.53E+12 1.63E+12 13.06269 0.933977
Median 6.26E+11 2.21E+11 12.14663 0.790657
Maximum 3.19E+13 1.53E+13 30.67382 3.147860
Minimum 4.68E+10 2.49E+10 2.160010 0.210398
Std. Dev. 8.34E+12 3.95E+12 7.663729 0.539226
Skewness 2.277406 2.717779 0.557253 2.275161
Kurtosis 7.146811 8.705562 2.614764 9.171603

Jarque-Bera 63.23724 103.4979 2.317548 97.99021
Probability 0.000000 0.000000 0.313871 0.000000

Sum 1.81E+14 6.50E+13 522.5076 37.35910
Sum Sq. Dev. 2.71E+27 6.09E+26 2290.577 11.33982

Observations 40 40 40 40
Cross sections 10 10 10 10



8) Langkah-Langkah Pengujian Hipotesis

Penelitian ini menggunakan aplikasi komputer bernama Eviews

versi 7 karena aplikasi ini yang mampu untuk mengolah data berupa

data panel dibanding aplikasi pengolah data lainya, secara umum

aplikasi ini mempunyai fitur yang hampir sama dengan pengolah data

lain seperti IBM SPSS, AMOS,dll hanya berbeda pada langkah-

langkah pengoperasianya. Dan berikut adalah langkah-langkah

pengolahan data menggunakan Eviews 7:

i. Tabulasi data yang diperoleh melalui Laporan keuangan dari 10

perusahaan selama 4 tahun terakhir melalui program Ms. Excel

2010.



Gambar 8.1

Hasil tabulasi Data Panel

Tahun Perusahaan MVP MRT PP TA
2010 ASII 19796457485460 10842000000000 19.02 0.81
2011 ASII 31941523427460 11990000000000 21.77 0.82
2012 ASII 29755411557900 15285000000000 19.87 0.82
2013 ASII 27528816135200 14433000000000 21.97 0.81
2010 GJTL 7927920000000 1089211000000 14.53 0.74
2011 GJTL 10105920000000 1660462000000 12.25 0.80
2012 GJTL 7840800000000 1478827000000 13.72 0.78
2013 GJTL 5854464000000 1820112000000 11.08 0.72
2010 LPIN 55250000000 27453118876 2.52 0.24
2011 LPIN 46750000000 24924985092 2.83 0.71
2012 LPIN 136000000000 26665573944 3.11 0.85
2013 LPIN 106250000000 46082485435 2.16 0.66
2010 PRAS 51156000000 153754605992 3.37 0.83
2011 PRAS 76440000000 108657694274 5.25 0.21
2012 PRAS 155820000000 119894122220 4.38 1.56
2013 PRAS 108780000000 153754605992 3.37 0.83
2010 KBLI 324586043667 181565915776 12.04 0.72
2011 KBLI 436788626663 225496386194 14.84 0.68
2012 KBLI 821483196935 300392842669 13.29 0.73
2013 KBLI 569027385194 297833900644 15.42 0.72
2010 SCCO 4008387630000 278343586975 14.59 0.74
2011 SCCO 6423698125000 202116192397 30.67 0.76
2012 SCCO 8222333600000 215827086051 29.81 0.76
2013 SCCO 9044566960000 299424993216 23.23 0.72
2010 VOKS 374004233550 251280814192 9.20 0.59
2011 VOKS 1122012700650 316069391959 10.83 0.79
2012 VOKS 789564493050 321885974691 13.12 0.80
2013 VOKS 615029184060 365801446338 12.32 0.76
2010 ARGO 436224685000 117242958000 11.27 3.15
2011 ARGO 369113195000 189495803000 9.70 1.53
2012 ARGO 335557450000 300495803000 7.36 1.17
2013 ARGO 402668940000 424209545000 6.27 1.35
2010 HDTX 383142750000 171591336555 7.14 0.24
2011 HDTX 291188490000 168167220716 11.50 0.85
2012 HDTX 1425291030000 197392830974 8.43 2.09
2013 HDTX 636016965000 192015441188 11.45 0.73
2010 MYTX 175999989240 126266464552 26.19 1.26
2011 MYTX 821333283120 188582846942 26.19 0.85
2012 MYTX 718666622730 189001290132 20.34 1.01
2013 MYTX 894666611970 262634505894 16.08 2.20

Sumber: tabulasi data MRT, PP, TA, dan MVP dengan Ms. Excel



j. Memasukan (import) data dari hasil tabulasi ke dalam program

eviews untuk dilakukan pengolahan data, dengan cara:

4. Klik File -> Open -> Foreign Data as Workfile.

5. Pilih file data excel hasil tabulasi yang telah disusun, next.

6. Melakukan setting sebagai berikut:

b. Basic structure dipilih Dated Panel

c. Pada Identifer series, untuk Cross section ID series diisikan

“perusahaan”, sedangkan Data series diisikan “tahun”.



k. Klik OK, maka data akan terstruktur seperti dibawah ini:

l. Memisahkan data panel berdasarkan perusahaan dengan cara:

5. Pada menu Proc pilih Reshape Current Page -> Unstack in

New Page.

6. Isi series name pada text box pertama dengan “perusahaan”.

7. Isi text box kedua dengan “tahun perusahaan”.

8. Sisipkan “_” (underscore) diantara * dan ? pada text box

ketiga.



5. Maka akan muncul series variabel data berdasarkan

“perusahaan”.

m. Memulai object data panel (Pooled) untuk membuat model regresi

yang diperlukan:

3. Pilih menu Object -> New Object -> Pool.

4. Identifikasi data cross section dengan mengetikkan label nama

masing-masing data cross section sesuai penamaan yang

diberikan, dalam penelitian ini menggunakan kode sebagai

berikut:

_ARGO, _ASII, _GJTL, _HDTX, _KBLI, _LPIN, _MYTX,

_PRAS, _SCCO, _VOKS



n. Mengestimasi Model Regresi OLS dengan cara:

4. Pilih menu estimate lalu memasukan spesifikasi dependent

variabel market value perusahaan dan common coefficient

konstanta di ikuti ketiga variabel bebas dengan memilih

“none” pada method dan mencetang balanced sampel, sebagai

berikut:

a. Pada kolom Specification, untuk Dependent variabel

diisikan mvp?

b. Pada Estimation method, untuk Cross-section pilih None,

Period pilih None, Weights pilih No weights.

c. Pada Regressors and AR () terms, untuk common

coefficients diisikan c mrt? pp? ta?, sedangkan Cross-

section specific coefficients dan Period specific coefficients

dikosongkan saja.

d. Pada Estimation settings, untuk Method pilih LS – Least

Square (and AR) dan Sample pilih 14.



Hasil regresi dengan menggunakan Pool Least Square

o. Mengestimasi Model Regresi MET dan mengujinya dengan model

OLS:

1. Estimasi model MET menggunakan spesifikasi yang sama

dengan model OLS namun menggunakan efek fixed pada



cross section, jadi pada Estimation method di kolom Cross-

section pilih Fixed.

Hasil regresi dengan menggunakan Fixed Effect Model (MET):



Variable Coefficient Std. Error t-Statistic Prob.

C 2.71E+10 1.68E+12 0.016151 0.9872
MRT? 1.318260 0.469974 2.804960 0.0092

PP? 1.57E+11 9.87E+10 1.587713 0.1240
TA? 3.32E+11 6.66E+11 0.497589 0.6228

Fixed Effects
(Cross)

_ARGO--C -1.93E+12
_ASII--C 6.40E+12
_GJTL--C 3.64E+12
_HDTX--C -1.42E+12
_KBLI--C -2.24E+12
_LPIN--C -6.03E+11

_MYTX--C -3.55E+12
_PRAS--C -1.03E+12
_SCCO--C 2.47E+12
_VOKS--C -1.74E+12

Effects Specification

Cross-section fixed (dummy variables)

R-squared 0.970850 Mean dependent var 4.53E+12
Adjusted R-squared 0.957895 S.D. dependent var 8.34E+12
S.E. of regression 1.71E+12 Akaike info criterion 59.43107
Sum squared resid 7.90E+25 Schwarz criterion 59.97995
Log likelihood -1175.621 Hannan-Quinn criter. 59.62953
F-statistic 74.93795 Durbin-Watson stat 2.774581
Prob(F-statistic) 0.000000

Sumber: data diolah peneliti tahun 2014 dengan eviews

Berikut adalah perbandingan model OLS dengan MET:

Sumber: data diolah peneliti tahun 2014 dengan eviews



5. Setelah mendapatkan hasil estimasi model, melakukan uji

chow dengan cara memilih menu View -> Fixed/Random

Effect Testing -> Redudant Fixed Effect – Likelihood Ratio.

6. Melakukan pengujian hipotesis sesuai pada kententuan uji

Chow seperti yang telah dijelaskan diatas.

Hasil Uji Chow sebagai berikut:

p. Mengestimasi Model Regresi MER dan mengujinya dengan model

MET:

1. Estimasi model MER dengan spesifikasi merubah cross section

efek menjadi random, yaitu mengubah Estimation method pada

kolom Cross-section pilih Random.



2. Menguji model MET dan MER melalui uji hausman dengan cara

memilih menu View -> Fixed/Random Effect Testing ->

Correlated Random Effect – Hausman Test.

3. Pengujian hipotesis sesuai ketentuan yang telah dijelaskan pada

sub bab sebelumnya.

Hasil regresi dengan menggunakan Random Effect Model:



Sumber: data diolah peneliti tahun 2014 dengan eviews

Perbandingan model MET dan MER seperti dibawah ini:

Sumber: data diolah peneliti tahun 2014



Hasil Uji Hausman

q. Setelah melakukan pengujian model, langkah selanjutnya

mengetahui hasil dari representasi dari model tersebut:

3. Pilih menu view -> Estimation Output untuk mengetahui

model yang terbaik.

4. Pilih menu view -> Representations untuk mengetahui

persemaan regresi tiap individu.

Perusahaan Nila C individual Total Nilai C
_GJTL--C 3100000000000 2220000000000

_SCCO--C 2390000000000 1510000000000

_ASII--C 399000000000 -481000000000

_LPIN--C 314000000000 -566000000000

_PRAS--C -74000000000 -954000000000

_HDTX--C -512000000000 -1392000000000

_ARGO--C -794000000000 -1674000000000

_VOKS--C -927000000000 -1807000000000

_KBLI--C -1380000000000 -2260000000000

_MYTX--C -2510000000000 -3390000000000
Sumber: data diolah peneliti tahun 2014 dengan eviews



9) GRAFIK PEMBAHASAN ANTAR VARIABEL

a) Pertumbuhan MVP dan MRT Perusahaan KBLI

Sumber: hasil olahan peneliti tabulasi data tahun 2014

b) Pertumbuhan MVP dan MRT Perusahaan ASII

Sumber: hasil olahan peneliti tabulasi data tahun 2014



c) Grafik Pertumbuhan PP dan MVP LPIN

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



d) Grafik Pertumbuhan PP dan MVP ARGO

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



e) Grafik Pertumbuhan TA dan MVP Perusahaan SCCO

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



f) Grafik Pertumbuhan TA dan MVP Perusahaan VOKS

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



g) Grafik Pertumbuhan MVP, MRT, PP dan TA Perusahaan

ASII

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



h) Grafik Pertumbuhan MVP, MRT, PP dan TA Perusahaan

KBLI

Sumber: hasil olahan peneliti tabulasi data tahun 2014

Sumber: hasil olahan peneliti tabulasi data tahun 2014



10)

Tabel 10.1

Perusahaan Manufaktur Sektor Aneka Industri

yang menjadi sampel penelitian

No. Kode Nama Perusahaan Jenis Industri

1. ARGO Argo Pantes Tbk Tekstil & Garment

2. ASII Astra International Tbk Otomotif & Komponen

3. GJTL Gajah Tunggal Tbk Otomotif & Komponen

4. HDTX Panasia Indo Resource Tbk Tekstil & Garment

5. KBLI KMI Wire and Cable Tbk Kabel

6. LPIN Multi Prima Sejahtera Tbk Otomotif & Komponen

7. MYTX Apac Citra Centertex Tbk Tekstil & Garment

8. PRAS Prima Alloy Steel Universal Tbk Otomotif & Komponen

9. SCCO Supreme Cable Manufacturing and

Commerce Tbk

Kabel

10. VOKS Voksel Electric Tbk Kabel
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